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Copyright Notice
No part of  this publication may be reproduced mechanically or electronically or in any form 
without the prior written permission of  CADlink. The software described in this manual 
is furnished under license and may only be used or copied in accordance with the terms 
of  such license. The information in this manual is for informational use only, is subject to 
change without notice and should not be construed as a commitment by CADlink. CADlink 
assumes no responsibility or liability for any errors or inaccuracies that may appear in this 
document. EngraveLab®, EngraveLab Foundation®, EngraveLab Expert®, EngraveLab 
Laser®, EngraveLab PhotoLaser Plus®, and EngraveLab Pro® are registered trademarks of  
CADlink Technology Corporation.

Written and designed at CADlink Technology Corporation

2440 Don Reid Drive, Ottawa, ON, Canada, K1H 1E1

Phone (613) 247-0850

Fax (613) 247-1488

Manual & Package Design by CADlink Marketing and Customer Support.

Printed in Canada. Product of  Canada.

© May 2010, CADlink Technology Corporation
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Contact Information
Once you have evaluated Vision Pro and determined the features and support that are of  
value to your shop, contact us for further information about features that pertain to your 
shop configuration. Our representatives will be able to provide advice about available 
packages based on your shop requirements.

Technical Support:
Phone: (602) 439-0700

Tech Support Website:

http://www.visionengravers.com/support/support.html

Sales: 
Email: sales@visionengravers.com

Phone Toll-free: (888) 637-1737

Phone: (602) 439-0600 

Company Address:
Western Engravers Supply Inc. 

(DBA Vision Engraving & Routing Systems)

17621 N. Black Canyon Hwy.

Phoenix, Arizona 85023 USA

Company Phone / Fax / Web:
Phone: (888) 637-1737

Local/International: (602) 439-0600

Fax: (602) 439-0500

Internet:  http://www.visionengravers.com
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Welcome to VisionPro
VisionPro is Computer Aided Design (CAD) software for laser and rotary engraving 
systems. VisionPro provides leading edge technologies as an all-in-one package that 
designers can adapt to run their production shops efficiently. VisionPro includes tools that 
support a wide variety of  applications, and development is ongoing to provide you with 
support for the latest technologies.

VisionPro provides simple, versatile tools that include designing with text, line art, and 
images (i.e., bitmaps). VisionPro also provides significant support for other design 
applications, so that unfinished or archived designs can be brought into VisionPro for pre-
production work.

Note: The available VisionPro features will vary according to the type of  VisionPro package 
that has been purchased.
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VisionPro Highlights

For both new and experienced users, the following sections highlight key 
features and functionality of  VisionPro:

□□ Design Layout
□□ Text Layout
□□ Vector Shapes
□□ Image Manipulation
□□ Third-Party Compatibility
□□ Toolbars and Palettes
□□ Fills and Strokes
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Design Layout

□□ Selection Tools - In addition to basic selection tools, objects can be selected according 
to their size, or select objects that are open paths. This provides an easy means of  
removing portions of  an imported or scanned file that would otherwise be difficult to 
clean up.

□□ Guides and Alignment - Control placement and layout using an assortment of  guides, 
alignment tools and hot keys.

□□ Start Sequence - Arrange a collection of  shapes into a specific order that controls how 
they are processed (e.g., cutting, badges), and optionally align the shapes on-screen.

□□ Measure Tools - Quickly obtain the distance between two points, and use the 
measuring line to resize the entire job proportionally.

□□ Job Schematics - Add dimensions and notes that can be printed as part of  a customer 
proof, and likewise be used as a guide when constructing the sign.

□□ Array - Create copies of  a shape and arrange them horizontally, vertically, as a grid, or 
on an arc.

□□ Nesting - Rearrange shapes within the plate size to minimize wasted material.
□□ InstantReplay, Storage Bin, Group Viewer - View, adjust and reuse operations 

and attributes that have been applied to objects. For example, drag-and-drop a useful 
gradient onto a new shape (Fig. 1).

□□ Stencils and Clipping - Set mask effects, whereby the top-most object becomes a 
mask for the underlying objects within a selection.

□□ Outlines, Inlines and Contour Objects - Add outlines and inlines to shape contours, 
so that elements of  the design have more “punch” or visibility.

□□ Transformations - Apply distortions and forming tools to vector shapes, such as 
adding a sense of  perspective, or emulating a flag or cylindrical effect.

□□ Fit Object to Path - Automatically create copies of  a smaller object and arrange them 
along the contour of  a larger object.

□□ Metamorphosis - Generate multiple graduated copies of  a shape, so as to create an 
even size and/or color transition between the start and end shape.

□□ Shadows - Add shadow effects to one-or-more shapes to create an impression of  
object depth, or the perception of  distance (Fig. 2).
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Fig. 2 - Choose the shadow type and use on-screen handles for the desired effect.

Fig. 1 - InstantReplay enables you to inspect object attributes and operations, which 
can be reused via drag-and-drop onto another object.
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Text Layout

□□ Adjust Text Attributes - Text can be manipulated using common word processor 
tools like text orientation, justification, slant, superscript, case control, line spacing, and 
bullets.

□□ Text Compression - When creating text frames, use flexible text compression rules to 
define how text should be adjusted with respect to the horizontal and vertical bounds, 
and set compression on line-by-line basis.

□□ Character Width Compression - Like text frame compression, characters can be set at 
a percentage of  their original design width.

□□ On-Screen Kerning - Use the on-screen kerning tools to define the spacing between 
letters, words and lines (Fig. 3).

□□ Font Sorting - Use the Font Detective to group fonts by type or similar typeface 
features.

□□ Typeface Preview - When choosing a font, an re-sizable preview shows how the 
current text would appear (Fig. 4). Alternative, an entire typeface can be displayed, so 
that the character styles can be evaluated at-a-glance.

□□ Character Picker - For unusual characters that are difficult to reproduce with a 
standard keyboard arrangement, use the character picker to display and select a desired 
character.

□□ Fit Text to Path - Place text along both open and closed paths using easy positioning 
and alignments tools, which include adjusting text offset from the path.

□□ Fit Text to Arc - Wrap text to a curved path, space multiple lines to a circular arc, 
invert text for window applications, and define text frame compression rules.

□□ Spell Check - The spelling can be checked when editing a text object (i.e., before 
converting the text to vectors), and for all text objects that are on the workspace.

□□ Braille Support - Define Grade 1 and Grade 2 Braille for assorted applications, such as 
Braille punch, raised dot, and photographic etching techniques.

□□ Style Painter - After setting attributes (e.g., typeface, kerning, height) for one text 
object use the Style Painter to transfer those attributes to other text objects.

□□ Automatic Text Frames - When creating lists or tables of  information (e.g., menus), 
use the Auto Layout feature to pre-position text frames, which can then be populated 
with data.

□□ Making Lists Using On-Screen Kerning - As an alternative to Auto Layout, use on-
screen kerning to align lists or tables of  information.

□□ Badges - Automatically create repeating designs (name badges, component labels, 
nameplates, etc.) by combining the base design with a plain text file (that contains the 
variable text of  each badge). Serialization tools are likewise available to providing badge 
numbering (letters or numbers).

□□ Font Customization - For customers that need distinguishing character styles for 
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Fig. 3 - Use guides in combination with on-screen kerning to arrange menu layouts.

Fig. 4 - When choosing a typeface, resize the preview for a magnified view of your text.
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their product identity, use the font editing tools to either customize an existing font, or 
design a new font from scratch.

□□ Avoid Distortion of  Stretched Text - If  text is simply scaled vertically or horizontally, 
then the serifs an other distinuishing marks can become distorted. Use the stretch tool 
(Fig. 5) as a means of  preserving qualities of  the original typeface.

Vector Shapes

□□ Basic Shape Types - Choose from a collection of  basic shapes that include circles, 
ellipses, rectangles, polygons, stars, arrows, fans, spirals, and monuments.

□□ Ruler and Dial Shapes - These are special shapes that automatically update tick marks 
and labels according to the size and positioning of  the shape.

□□ Barcode Shapes - Standard barcodes can be automatically generated in both common 
and uncommon industry standards that conform to specified width and height limits.

□□ Parametric Shape Functionality - When editing basic and specialized shapes, context 
sensitive handles and SmartBar parameters are used to provide discrete control over the 
shape appearance.

□□ Decorative Borders and Clip Art - Use the decorative border tool or combine 
premade border clip art to enhance the effectiveness of  your designs.

□□ Compound Shapes - Combine multiple overlapping shapes into an integrated object, 
and set the winding order for the desired effect.

□□ Welded Shapes - Bond overlapping shapes into entirely new combined objects (Fig. 6), 
and create bleeds that prevents gaps between adjacent layers of  media.

□□ Three Types of  Node Editing - Choose the mode of  node editing (polygon, polyarc 
or freehand) that is most natural for your design style. Convert between each type as 
needed.

□□ Node Editing Hotkeys - Common node editing functions are available as hotkeys, 
such as joining, breaking and aligning nodes.

□□ Segment Node Edit Modes - When node editing, select two points of  the shape and 
then force a corner, arc or line to be formed.

□□ Round Corner Tools - Rouding of  both inside and outside corners, and rounding of  
individual corners.
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Fig. 5 - Instead of scaling, use the Stretch tool to avoid distortion of the typeface 
characteristics.

Fig. 6 - The weld tools have a variety of applications, often used to bond 
overlapping shapes, or to create traps between adjoining shapes, so as to 
avoid potential gaps that can occur due to exposure to the elements.



22 VisionPro User Guide

Image Manipulation

□□ CMYK Color Mode - In addition to previous RGB, Grayscale, Indexed Color and 
Monochrome, VisionPro now supports CMYK colors and images.

□□ Image Size and Super Size - Two image resampling tools are available, which retain 
image quality when scaling the image in terms of  pixel size or image resolution (dpi).

□□ Contour Bitmaps - Use vector artwork to create images composed of  three-
dimensional chiseled or beveled patterns (Fig. 7).

□□ Pattern Fill Bitmaps - Tile specially prepared bitmaps to form a cohesive pattern. 
These pattern fills can be applied to vector shapes.

□□ See Through Bitmap Patterns - Create a see-through bitmap pattern that can be 
tiled using the See Through Sign Wizard. Such patterns are used to simulate perforated 
media for window applications, so that viewers can see objects behind the design.

□□ Fluid Mask Knockout Backgrounds - Use intuitive paint-by-region tools to quickly 
and seamlessly remove the backgrounds from images. Please note that Fluid Mask is an 
optional add-on.

□□ Image Color Adjustments - Image tools include adjustments for color levels, 
contrast/brightness, hue/saturation, curve values (highlights/midtones/shadows), 
invert (i.e., create photographic negative), posterize, histo contrast, stretch intensity, 
histo equalize, balance colors, and swap colors.

□□ Image Filters - Image effects include sharpen tools, blur tools, introducing noise, 
despeckle, emboss, solarize, oilify, mosaic, spatial filter, halftone, intensity detect, and 
remove red eye.

□□ Image Plug-in Effects - In addition to plug-ins that you purchase from third-parties, 
VisionPro includes Richard Rosenman, Redfield, Harry, Alien Skin, and CADlink plug-
ins.

□□ Plug-in Effects for Vectors - Plug-ins can be applied to vector artwork in 
VisionPro (Fig. 8). A Plug-ins Helper dialog is used to define how the effect should be 
applied.

□□ Vectorizing Images into Line Art - Artwork in vector form can often be easier to 
edit, and it can be scaled without introducing flaws. VisionPro provides both manual 
vectorizing tools, and a vectorizaton wizard that provides ease-of-use steps that include 
Super Size Image and Fluid Mask tools.

□□ PhotoMachine Cut Images - Using image curve values (highlights/midtones/
shadows), create a cut pattern that simulates the image when viewed from a distance.

□□ Centerline Tracing - Create vector paths that trace the centerlines of  the given 
artwork, which can then be used for etching or tracing effects.
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Fig. 8 - VisionPro provides a means of using vector artwork in combination 
with plug-in effects. In this example, the resulting effect was incorporated 
into the background image, and the original text remained intact. 
Alternatively, vector artwork can be converted into image data.

Fig. 7 - Using the Render Contour Bitmap tool, line art and text can be converted 
into bitmaps that simulate the appearance of beveled edges.
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Third-Party Compatibility

□□ Importing - VisionPro supports an exhaustive collection of  file types that can be 
imported, so that legacy formats and design collections can be recovered and reused.

□□ Exporting - Likewise, VisionPro can export designs in commonly used bitmap-type 
formats and mixed format (i.e., vector and/or bitmap data), so that you can collaborate 
with other designers, and present designs for evaluation by your customers.

□□ Desktop Scanner - When used in conjuction with a desktop scanner, VisionPro can 
import either a bitmap image or vector artwork. In addition, a wizard interface provides 
a step-by-step process for tracing scanned images.

□□ Digitizer Tablets - Design work can be performed in VisionPro using a digitizing 
tablet. This is an option provided for designers that prefer this type of  input device.

Toolbars and Palettes

□□ Tools Toolbar - This is the main VisionPro toolbar, typically docked at the left of  the 
workspace. Most of  the tools are organized in flyouts that can be undocked as floating 
toolbars for quick access (Fig. 9).

□□ Custom Toolbars - In addition to the Tools toolbar, you can create your own toolbars 
with your most frequently used tools. Toolbars can either be docked along the side of  
the workspace, or undocked as floating toolbars.

□□ Shop Palette - This main color palette is typically docked along the bottom of  the 
workspace. By default, left-clicking will set the fill color of  a selected shape, and right-
clicking will set the stroke color.

□□ CMYK Colors - In addition to previously supported color spaces of  RGB, HLS and 
LAB, colors can now be defined in either CMY or CMYK color spaces.

□□ Default Fill and Stroke Colors - When no object is selected, the default fill and 
stroke colors are set by left-clicking and right-clicking Shop Palette colors, respectively. 
Alternatively, the default colors can be fixed for new text and shapes.

□□ Job Palette - This palette (Fig. 10) lists the colors that are currently being used as fill or 
stroke colors on the workspace.

□□ Modifier Keys - The palettes have special key functions. For example, use [Shift + 
click] in the Job Palette to select all shapes of  the given fill color.

□□ Sheet Layer Palette - Design elements can be organized onto separate layers, so that 
parts of  the design can be edited in isolation from the design as a whole.

□□ Sort Palette Colors - Rearrange Shop Palette colors to suit your preferred method of  
viewing colors, such as the colors that are currently in use.

□□ Custom Color Creator - In addition to preconfigured color palettes included with 
VisionPro, you can define new colors and organize them into custom palettes.

□□ Shop Palette Wizard - Construct a custom Shop Palette. This step-by-step interface 
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Fig. 9 - For quick access, the Tools toolbar flyouts can be detached to become 
floating toolbars. Similarly, the custom toolbars along the top of the workspace 
can also be detached.

Fig. 10 - The Job Palette will show all the colors currently 
in use by workspace objects, so that they can be quickly 
located for new objects.
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provides a convenient means of  browsing and choosing colors from the palettes 
included with VisionPro. 

Fills and Strokes

□□ Pattern Fills - Tile a small bitmap to fill the entire area of  a vector shape (Fig. 11). 
Included with VisionPro are a collection of  tile-friendly bitmaps, or use your own from 
third-parties.

□□ Strokes with Locked Proportions - By applying a stroke that has locked proportions, 
scaling the object will cause the stroke to become thicker or thinner according to the 
amount of  scaling.

□□ Strokes Above/Below the Shape - Thick strokes are like an object that overlaps the 
main shape. To achieve a desired effect, a thick stroke can be set as being either above 
or below the principal shape.

□□ Corner and End Caps Styles for Strokes - Choose the appearance of  how thick 
strokes are shaped and terminated.

Fig. 11 - The Pattern Fills tool tiles a bitmap pattern across a 
vector shape. Rather than create multiple copies of the bitmap 
(i.e., inflating the file size), the original bitmap remains linked from 
the hard drive.
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Chapter 1

The VisionPro Workspace

In This Section…
□□ Workspace customization
□□ Locations of  menus, color palettes and toolbars
□□ Methods of  creating shapes and text
□□ Selecting shapes and basic layout controls
□□ Setting fill and stroke colors
□□ Creating gradient fills and color blends

The center of  the VisionPro environment is the workspace, which includes grid lines, 
horizontal and vertical rulers, and a rectangular outline to represent the plate size.

The plate size dimensions are usually set equal to the material that is being machined, such 
that the placement of  art and text can be visualized. However, for some design work it may 
be more convenient to hide the plate size.

Quick Customization Tips
Depending on the other software packages that you are familiar with, you may have certain 
preferences for how the workspace is set up. The following are some of  the VisionPro 
workspace settings that may be of  immediate use to you:

□□ Options menu >> VisionPro Setup >> General Preferences – Set the units of  
measurement, as well as the grid size

□□ View menu >> Show Plate – This is used to turn on the rectangular area that helps 
you visualize the size of  the material that you are working on

□□ View menu >> Show Fill – This is used to show the fill color of  line art shapes. Turn 
this off  to see only the wireframe view of  shapes

□□ View menu >> Show Bitmap Outlines – This is used to show only a wireframe 
rectangle of  bitmap shapes

□□ View menu >> Link Show Fill and Bitmap Outlines – When Show Fill is toggled, 
also causes wire frames to be shown instead of  bitmap image.

□□ View menu >> Show Tool Diameter – Iillustrate the widths that tool paths require
□□ View menu >> Show Grid – This is used to display the grid lines
□□ Options menu >> Grid – This is where objects can be set to snap to the grid lines
□□ Options menu >> Guides – This is where guidelines can be created or removed
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Menu, SmartBar, and Toolbars
Above the workspace is the menu bar, the SmartBar, and one-or-more toolbars.

The menu bar is typical of  most Windows applications.

The SmartBar is a special, dynamic toolbar that displays controls that are specific to the 
current operation that is being edited.

The other toolbars are customizable. Buttons may be added or removed from these 
toolbars. New toolbars may also be created.

Color Palettes
Below the workspace are the color palettes.

The Shop Palette is the main color palette that displays colors that are available for use as 
either fill or stroke colors.

The Sheet Layer Palette provides the ability to arrange shapes on separate layers. Each 
layer can represent a different type of  media (black vinyl, white vinyl, etc.).

Tools Toolbar
To the left of  the workspace, the Tools toolbar contains the main shape creation and 
manipulation tools. For most of  the Tools buttons, clicking will open additional toolbars.

Job Palette
To the right of  the workspace, the Job Palette lists the process colors, foil colors, primers, 
and halftones that are currently in use on the workspace.

In addition to listing colors, the Job Palette can be used to perform global search-and-
replace of  colors, primers, halftones, etc.

Set all red shapes to a blue fill color
1.	 Suppose that you have several red shapes
2.	 In the Job Palette, click the ellipsis button and choose Color View from the context 

menu
3.	 Note that the red color appears in the Job Palette
4.	 From the Shop Palette, drag a blue color plate and drop it onto the red Job Palette color
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Replace all shades of a spot color
1.	 Suppose that you have five shapes with different tints of  a gold spot color, say 100%, 

80%, 60%, 40%, and 20% tint
2.	 In the Job Palette, click the ellipsis button and choose Foil View from the context 

menu
3.	 Note that the Job Palette lists the different shades of  gold as a single color plate
4.	 From the Shop Palette, drag a green spot color and drop it onto the gold Job Palette 

color

Shape Creation
From the Tools toolbar, the Shape Tools (Fig. 12) are used to create circles, rectangles, 
polygons, stars, arrows, and fan shapes. These shapes are sometimes referred to as 
“parametric shapes” because they have extra editing handles for adjusting the shape 
parameters, such as number of  sides, notched corners, rounding, etc.

From the Tools toolbar, the Graphic Edit Tools (Fig. 13) are used to edit scanned or 
imported vector artwork. Often, scanned artwork has extra nodes and rough edges that need 
to be “cleaned up” using these node editing tools. In addition, the Graphic Edit Tools can 
be used to draw freehand shapes and trace simple artwork.

Fig. 12 - Basic shapes that are available from the 
Shape Tools flyout.

Fig. 13 - Node editing is available 
from the Graphics Edit Tools 
flyout.
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Removing excess nodes when node editing
1.	 From the Shape Tools flyout, create an oval shape.
2.	 Select the oval and choose Arrange menu >> Convert to Polygon.
3.	 Double-click the oval to begin node editing.
4.	 Drag a marquee to select all of  the nodes.
5.	 Press the ‘ u ’ key to select only alternate nodes.
6.	 Press the [DEL] key.

From the Tools toolbar, the Ginsu Knife Tools (Fig. 14) are used to subdivide selected 
shapes. The Open path tool will leave the subdivided objects as open paths, whereas the 
Close path tool will create closed paths.

When a Ginsu Knife tool is chosen, click on the workspace to place one-or-more cutting 
nodes that intersect the selection. Then click Apply to subdivide the selection.

Text Creation
From the Text Tools flyout (Fig. 15), the Text Compose tool is used to create text shapes. 
When creating text, the text frame determines the bounds of  the text.

Methods of setting the text frame:
□□ Click on workspace: This will set an entry point for the text. As text is typed, the text 

frame will expand and contract to enclose the text.
□□ Click along a shape contour: Hold the cursor over the edge of  a shape, such that the 

cursor turns black. Click and type text to fit text to the shape contour.
□□ Click and drag marquee: Dragging a marquee with the mouse will set the text 

frame bounds. As text is typed, the text frame will remain fixed, and the text will be 

Fig. 14 - Subdivide shapes using the 
Ginsu Knife Tools flyout. Fig. 15 - Text Compose is available from the 

Text Tools flyout.
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constrained according to the text frame properties.
□□ Press [Shift] and click on workspace: This will set the text frame equal in size to the 

plate size. 
□□ Frame Text Compose button: This button will set the text frame equal to the plate 

size.

The Spell Check tool will check the spelling for all text shapes.

The Text Underline tool will create underlined text. Right click to set the underline 
properties.

From the Transform menu, the Fit Text to Arc command is used to fit the text to a circular 
contour.

From the Transform menu, the Fit Text to Path command is used to fit the text shape to 
the contour of  another shape.

From the Weld Tools flyout (Fig. 16), the Basic Weld is used to bond script lettering, such 
that there is no overlap between adjacent characters.

However, keep in mind that the result of  the weld will no longer be a text shape, so make 
sure that the text is correct before doing the weld.

Fig. 16 - For script lettering, kern the lettering 
and then use the Basic Weld tool.



32 VisionPro User Guide

Selecting Shapes
Left-click a shape to select it. To add a shape to the current selection, press the [Shift] key.

To select multiple shapes, click-and-drag the cursor to form a marquee. All shapes that are 
within the marquee will be selected. Alternatively, press the [Ctrl] key when dragging the 
marquee, and all shapes that are overlapped by the marquee will be selected.

By default, a shape can be selected by clicking within its filled region. Alternatively, press the 
[ALT] key to only allow a shape to be selected by clicking along its contour. This is useful 
when you are attempting to select from among several clustered shapes. For example, when 
node editing a shape that overlaps other shapes, press the [ALT] key to prevent accidentally 
choosing a different shape.

VisionPro can be set to select shapes only when they are clicked along their contours. From 
the Options menu, choose VisionPro Setup >> Selection Tool Settings. If  the “Use 
Filled Region to Select” option is unchecked, then shapes can only be selected by clicking 
along their contours.

The Job Palette may be used to select shapes according to their color.

Select all shapes of a specific color or tint
1.	 In the Job Palette, click the ellipsis button and choose Color View from the context 

menu.
2.	 Press [Shift] and then left-click a color in the Job Palette.
3.	 All shapes of  that color will be selected.

Select all shapes of a specific spot color
1.	 In the Job Palette, click the ellipsis button and choose Foil View from the context 

menu.
2.	 Press [Shift] and then left-click a color in the Job Palette.
3.	 All shapes of  that spot color will be selected, including tints of  that color.

Properties of Shapes
When a shape is selected, nine editing nubs appear about the shape. These nubs are used 
to move, resize, scale, flip, and rotate the shape. The SmartBar displays the position, size, 
rotation, color information, and type of  the shape.

Of  the nine editing nubs, the SmartBar indicates the Current Nub with a red highlight, and 
the SmartBar x and y values represent the position of  the Current Nub. When the SmartBar 
is used to resize a shape, the shape will be resized with respect to the Current Nub.

From the View menu, the Show InstantReplay item will activate the InstantReplay window, 
which is used to list the changes (properties and operations) that have been applied to a 
shape. Double-clicking will edit the property or operation without changing the order in 
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which it was applied. Pressing the [Delete] key will reverse changes to a selected property, 
and it will remove a selected operation.

Using the cursor keys, a shape is moved (“Nudged”) one pixel at a time. Holding [Shift] will 
move the shape by five pixels.

When rotating a shape, press [Ctrl] to constrain rotation to the Snap Angle, which is set on 
the General Preferences dialog.

When dragging a shape, press [Ctrl] to constrain the move horizontally or vertically. In 
addition, pressing [ALT] will create a duplicate of  the moved shape.

From the Layout menu, the Size/Move commands are also used to modify the shape 
properties, as follows:

Layout Menu Size/Move Commands
□□ Size: Set width and height of  shape, or set scaling amount.
□□ Move: Place shape at an absolute position, or move the shape by a relative amount.
□□ Slant: Slope or skew the shape either horizontally or vertically.
□□ Rotate: Rotation can be with respect to a specific point on the workspace.
□□ Mirror: Flip the shape either horizontally or vertically.
□□ Flip: Similar to mirror, except that the line of  reflection can be adjusted.
□□ Clear Size/Move: Remove all Size, Move, Slant, Rotate, Mirror, or Flip operations that 

have been applied to the shape.

Adding Fills and Strokes
The Shop Palette contains the colors that can be applied to shapes as fill or stroke colors. In 
addition, the Job Palette will list all colors that are currently being used on the workspace.

For a selected shape, left-clicking a Shop Palette color will change the fill color, and right-
clicking will change the stroke color. The Shop Palette also has a Line/Fill button, which is 
used to alternate this behavior.

When there is no selection, the SmartBar indicates the default fill and stroke colors that are 
applied to new shapes. Within the Shop Palette, a white hairline is drawn about the default 
fill color.

A newly created shape has no stroke, so its stroke color is not initially visible. From the 
Stroke and Fill Tools flyout, the Line Style tool is used to add a stroke.

At the far-left of  the Shop Palette are the Invisible Color and Clear Color. All other colors 
have a letter designation (P, SF, or SC) to indicate their type.
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Types of Colors
□□ Invisible Color: Indicates the absence of  color. For example, when a shape fill is 

Invisible, only its thick line attributes (i.e., its stroke) are available for printing or cutting.
□□ Process (P): Use the Process option when process colors are being used (i.e., where 

CMYK colorants are combined to produce a given color).
□□ Spot Foil (SF): Used to represent colors that will be printed with foil cartridges (i.e., 

pure colorants are applied, rather than by combining proportions of  CMYK). Shades 
of  spot foils are created by adjusting the Tint values (less than 100%), or by applying a 
gradient.

□□ Spot Color (SC): Defined in terms of  the LAB color space, and used to represent 
distinct color planes when printing color separations.

Gradients and Pattern Fills
From the Stroke and Fill Tools flyout (Fig. 17), the Gradient Fill tool is used to create a 
process color gradient. When printed, this fill will be rendered using CMYK colorants.

From the Stroke and Fill Tools flyout, the Pattern Fill tool is used to tile a bitmap pattern 
on the shape.

Fig. 17 - Apply gradient fills and patterns from 
the Stroke and Fill Tools flyout.
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Blends using Metamorphosis
From the Transform menu, one of  the functions of  the Metamorphosis tool is to create 
a smooth gradient blend between two line art shapes. Depending on the metamorphosis 
setting, either new colors can be created, or existing Shop Palette colors will be used.

□□ Target layer: Use the currently selected Shop Palette color
□□ Match layers: Locate and use only colors that are currently in the Shop Palette
□□ New layers: Create and add new colors to Shop Palette

Metamorphosis creates the effect of  a gradient blend by creating a large number of  
intermediate shapes. For example:

Create a metamorphosis color blend
1.	 Create some blue text with 1” height.
2.	 Create a red duplicate of  the text with 5” height.
3.	 Select both text shapes and choose Metamorphosis from the Transform menu.
4.	 Set the Mode to New Layers, such that new color plates will be created.
5.	 Set a high Count value, such as 64.
6.	 Click OK, and the resulting series of  line art shapes will create the effect of  a gradient.

To create a blend that fades to “no color,” then assign the Invisible Color to one of  the 
shape fills.
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Chapter 2

Shape Manipulation

In This Section…
□□ Arranging collections of  shapes
□□ Applying special effects to shapes
□□ Clipping intersecting shapes
□□ Dissecting shapes with the Ginsu Knife
□□ Converting text shapes into line art

There are many tools available that allow you to modify or combine shapes.

From the Arrange menu, the Order To Front and Order To Back commands are used to 
control the display order in how shapes appear above each other. Similarly, shapes can be 
moved Forward and Backward in the display order.

From the Layout menu, the Group command is used to bind shapes into collections, which 
allows the shapes to be moved as a single unit. The Ungroup command is used to release 
the collection. 

Double-clicking a group of  shapes will open the Group Viewer, which lists the shapes 
that are part of  that group. Selecting a shape within the Group Viewer will display all the 
attributes and operations that have been applied to that shape.

Ways to use the Group Viewer
1.	 Double-click an attribute for one of  the shapes within the group. Changes to that 

attribute will only apply to that shape without changing the group.
2.	 Drag a color from the Shop Palette, and drop it onto the “Layer” attribute within the 

Group Viewer. The fill color of  the shape will be changed.
3.	 Select a shape that is not part of  the group, and use InstantReplay (see InstantReplay) 

to look at the operations that have been applied to that shape. Drag an operation from 
the InstantReplay window, and drop it into the list of  operations displayed within 
the Group Viewer. The operation will be automatically re-applied to the shape that is 
selected within the Group Viewer.

From the Tools toolbar, the Weld Tools are used to fuse shapes together into a combined 
shape. Alternatively, the weld tools can clip overlapping shapes. In either case, the weld tools 
actually create new shapes.
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From the Arrange menu, the Clipping command is used to clip overlapping shapes to the 
top-most shape. This is similar to a weld, except that the original shapes are not destroyed, 
and the Clipping Clear command can be used to reverse the effect.

From the Tools toolbar, the Ginsu Knife Tools are used to subdivide shapes. The 
subdivided shapes can either become closed contours, or they can be left as open paths.

From the Arrange menu, the Text to Graphics command is used to convert text shapes 
into line art. This is usually done in order to combine the text shapes with other line art.

Outlines and Inlines
From the Transform menu, the Outline command is used to add the effect of  contour 
lines either around a shape (Outline), or within the shape contour (Inline). The Create 
Mask option will weld the resulting outlines and/or inlines into a single shape.

From the Transform menu, the Contour Object command is similar to the Outline 
command. A positive Offset will create an outline, whereas a negative Offset will create an 
inline. Overlapping portions of  the contour object will be automatically welded into a single 
shape.

Miter Limit
When applying an outline, the Miter Limit is a distance that is expressed as a percentage of  
the outline or inline thickness. For a sharp corner of  the original shape, the resulting outline 
corner may be quite steep. If  the Clipped button is enabled, then the outline corner will be 
clipped as per the Miter Limit. Only corners that are less than or equal to 90 degrees will be 
clipped.

Fig. 18 - Two star shapes with outlines. The 
second star has an outline that has been 
clipped at 70%.
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Transformation
From the Transform menu, the Transformation command is used to apply special effects 
and distortions to shapes and/or images. Each transform comes with two versions: Vertical 
and Horizontal (Fig. 19).

Note: The following three transformations are not available when editing images: 
Perspective Curve Vertical, and neither of  the Fit to Circle transforms.

Metamorphosis
From the Transform menu, the Metamorphosis command is used to blend two shapes 
together, and multiple intervening shapes with distinct gradients can be created.

Fig. 19 - There are six categories of Transformation commands available, 
all but three of which can also be applied to images.
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Shadow
From the Transform menu, the Shadow command is used to add background shapes that 
create the appearance of  shadows (Fig. 20).

□□ Block Shadow: The Block Shadow is used to give shapes the perception of  depth.
□□ Perspective Shadow: The Perspective Shadow is used to give shapes the perception of  

distance.
□□ Drop Shadow: The Drop Shadow is similar to the Block Shadow, though the perceived 

space between the original shapes and their shadows is not filled.
□□ Cast Shadow: The Cast Shadow is used to create the perception of  a light source, such 

that the shapes project a shadow as if  onto a nearby surface.

At the far-right of  the Shadow SmartBar, the Outline checkbox (Fig. 21) is used to increase 
the thickness of  the shadow effect. When creating a shadow outline, the following outline 
options may be used:

□□ Point: Corners of  the shadow outline are sharp
□□ Miter: Corners of  shadow outline are clipped (See Fig. 18 for the Miter Limit 

description under Outlines and Inlines for an example)
□□ Round: Corners of  the shadow outline are rounded and smooth
□□ Relief  Shadow: Create a gap (equal to the Thickness setting) between the shape and  

the shadow outline

Fig. 20 - The available Shadow styles are (a) Block 
Shadow, (b) Perspective Shadow, (c) Drop Shadow, and 
(d) Cast Shadow.

(a) (b)

(c) (d)
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Decorative Border
The Decorative Border tool is used to create a border shape that encloses either the plate 
size or selected shapes. The Decorative Border tool (Fig. 22) is available from both the 
Shape Tools flyout, and the Layout menu.

The Clip Art Viewer is also used to choose from a collection of  preset decorative borders. 
Dozens of  borders are available from the clip art sign blanks directory.

Round Corners
From the Transform menu, the Round Corner tool is used to create rounded corners for 
either inside or outside contours of  vector shapes.

Most of  the parametric shape tools include extra controls for rounding corners. However, 
the Round Corner tool is useful for scanned or imported vector shapes that would 
otherwise require node editing to create the rounded corners.

Fig. 21 - As an option, tick the Outline 
checkbox and increase the shadow thickness.

Fig. 22 - Decorative Border styles 
available from the SmartBar.
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Stencils
From the Shape Tools flyout, the Stencil tool (Fig. 23) is used to create the appearance of  
work that has been designed using a stencil pattern. Other shapes will be visible beneath the 
stencil shape.

A common stencil technique is to duplicate the shape, apply a different fill color, and then 
apply a stencil to the duplicate.

Creating a striped stencil pattern
1.	 Create a shape and apply a red fill color.
2.	 From the Options menu, choose VisionPro Setup >> General Preferences.
3.	 In the General Preferences dialog, the Duplicates section has X Offset and Y Offset 

settings. Set both these fields to zero.
4.	 Click OK to close the General Preference dialog.
5.	 Select the shape and choose Edit menu >> Duplicate (or use the [Ctrl + D] 

shortcut).
6.	 The duplicate has now been created precisely above the original. However, the duplicate 

is now the current selection.
7.	 With the duplicate still selected, apply a blue fill color.
8.	 From the Shape Tools flyout, apply a Stencil effect to the duplicate.
9.	 After the Stencil has been applied, the original shape will show through from below the 

duplicate.

Fig. 23 - Stencil styles available from the 
SmartBar.



43Layout Tools

Chapter 3

Layout Tools

In This Section…
□□ Creating guides for aligning design elements
□□ Aligning shapes to the grid, plate size, or other shapes
□□ Resetting the grid lines and ruler origin
□□ Creating arrays and sequences of  shapes
□□ Nesting shapes to minimize wasted media
□□ Automated badge and name plate creation
□□ Serializing text data for badges

Guidelines
When dragging shapes, guidelines are used for precise alignment. A shape will “snap” to the 
location when it is dragged over a guideline.

□□ When there is no selection, right-clicking on the workspace will open the Edit Guides 
dialog.

□□ Under the Options menu, choosing Guides >> Edit Guides will open the Edit 
Guides dialog.

□□ Right-clicking a ruler will create a guide.
□□ For a selected shape, press [Shift] and right-click the shape nubs to create guides (not 

when editing a parametric shape).
□□ To add guides when node editing, press [Shift] and right-click the node.
□□ When dragging a guide, press [Shift] to constrain the guide to the nearest ruler 

increments.
□□ To lock guides in place, open the Edit Guide dialog and check the Lock Guides 

checkbox.
□□ To temporarily hide the guides, choose Options menu >> Guides >> Use Guides. 

The shortcut to toggle guides On/Off  is [ALT + W].
□□ To remove a guide, press [Shift] and right-click the guide (when there are no objects 

selected).
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The Grid and Align Palette 
Press the [Control] key and right-click the workspace to display the Align Palette, which is 
used to align shapes with respect to the grid. Typically, these tools are applied to shape nubs, 
though they may also be used when node editing.

□□ Set Origin: Set the grid origin to the selected location.
□□ Resize Grid: Resize the grid increments based on the distance between the selected 

location and the grid origin.
□□ Snap to Grid Intersection: Move the shape, such that the nub is at the nearest grid 

intersection.
□□ Snap Vertically: Move the shape, such that the nub is at the nearest horizontal grid 

line.
□□ Snap Horizontally: Move the shape, such that the nub is at the nearest vertical grid 

line.

From the Options menu, the Reset Origin command will set the grid size according 
to the General Preferences setting. This is useful when the Set Origin or Resize Grid 
commands have been used.

Alignment Hot Keys
The following a commonly used hot keys for aligning shapes. More hot keys are listed in 
Appendix A.

Align Selected Shapes Quickly

[ALT + 1] Align shapes along left edge of  
bounds

[ALT + 2] Center shapes vertically

[ALT + 3] Align shapes along right edge 
of  bounds

[ALT + 4] Align shapes along top edge of  
bounds

[ALT + 5] Center shapes horizontally

[ALT + 6] Align shapes along bottom 
edge of  bounds

[ALT + 7] Center shapes both 
horizontally and vertically
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Align Shapes to the Plate Size

[ALT + Insert] Align with top edge of  plate size

[ALT + Home] Center vertically along width of  plate 
size

[ALT + Page Up] Align with bottom of  plate size

[ALT + Delete] Align with left edge of  plate size

[ALT + End] Center horizontally along height of  
plate size

[ALT + Page Down] Align with right edge of  plate size

Align Shapes to Last Selected Object

[L] Left – Align with the left edge of  the last 
object.

[R] Right – Align with the right edge of  the last 
object.

[T] Top – Align with the top edge of  the last 
object.

[B] Bottom – Align with the bottom edge of  the 
last object.

[E] Horizontally – Center horizontally along 
height of  last object.

[C] Vertically – Center vertically along width of  
last object.
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Alignment Tool
From the Layout menu, choose Arrange and Distribute >> Alignment. The Alignment 
controls will appear in the SmartBar (Fig. 24).

Note: The Align command will reapply whatever settings were last used with the 
Alignment tool.

□□ Align to plate size: Shapes are aligned relative to the plate size
□□ Align to grid: Shapes are aligned relative the grid lines
□□ Align to last object: For several selected shapes, align the shapes according to the last 

shape selected in the group
□□ Align to selected: For several selected shapes, align the shapes according to the 

bounding box that is around the selection

When aligning text shapes, the following options are also available from the 
SmartBar (Fig. 25):

□□ Treat Text Line as an Object: Enabled when using equal vertical spacing. For a 
text paragraph that has multiple lines, this option will cause each line to be aligned 
separately.

□□ Ignore Descenders: Enabled when using equal horizontal spacing. Causes the text 
descenders to be ignored, such as for letters ‘j’, ‘p’, and ‘q’. Alignment is performed with 
respect to the text baseline.

Fig. 24 - Alignment options available from the SmartBar.
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Array
From the Layout menu, the Array command is used to arrange multiple copies into rows, 
columns, or arcs.

For shapes arranged on an arc, specify the arc radius and the range of  angles over which the 
copies are spread.

When creating an array, the copies can be automatically rotated. The Spin Each option will 
rotate each subsequent copy by the Spin Amount. The Total Spin option will progressively 
rotate each copy, such that the final copy is rotated by the Spin Amount.

Start Sequence
From the Layout menu, the Start Sequence commands are available from the Sequence 
flyout: Start Sequence, Start Sequence by Vector, Start Sequence by List, and Start 
Sequence by Traits.

The Start Sequence command has two uses. The first usage is to arrange the database order 
of  the shapes, which determines the order in which the shapes are output to a cutter. The 
second usage is to arrange shapes graphically on-screen.

Creating a Sequence
1.	 Select the first shape.
2.	 From the Layout menu, choose Sequence, and Start Sequence.
3.	 Click each subsequent shape, one-by-one. A connecting line is drawn as each shape is 

clicked.

Fig. 25 - Additional alignment options.
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4.	 Click on an empty portion of  the workspace to finish editing.

The Start Sequence by Vector command is similar to the Start Sequence command, 
except that multiple shapes are added to the sequence by drawing a line. 

Creating a Sequence by Vector
1.	 Select the first shape.
2.	 From the Layout menu, choose Start Sequence by Vector.
3.	 Click and drag the cursor to form a line. All shapes that are intersected by this line will 

become part of  the sequence.
4.	 Click on an empty portion of  the workspace to finish editing.

Both the Start Sequence and Start Sequence by Vector commands can be used to arrange 
shapes. Repeat steps (1-3), and then right-click and drag the shapes across the workspace.

The Start Sequence by List command will open the Sequence by List dialog, which 
provides a visual list of  all the shapes that are on the workspace. Shapes at the front of  this 
list will appear above other shapes, and shapes at the back will appear below. The mouse can 
be used to drag shapes within this list. Alternatively, select a shape and use the To Front, To 
Back, Forward One, and Back One buttons. To use the Reverse Order button, at least 
two shapes must be selected.

□□ Holding the [Shift] key will align the shapes according to their lower-left bounding box 
corner.

□□ Holding the [Control] key will constrain the shapes either vertically or horizontally.

The Start Sequence by Traits command will open the Sort dialog, which will arrange the 
shapes according to their horizontal, vertical, or relative (Nearest) positions. Alternatively, 
the Database order arranges the shapes according to the order in which they were created.

Nesting
From the Arrange menu, the Nesting command (Fig. 26) is used to rearrange shapes into 
the minimum area necessary for printing or cutting the shapes. In this manner, the amount 
of  wasted media required to output the shapes is minimized. Nesting may also be used to 
rearrange shapes across a non-rectangular area, such as leftover media.

To nest the individual letters of  a sentence, the Text to Graphics command must be used 
first. Otherwise, the entire sentence will be nested without rearranging the individual letters.
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□□ Specify Corners: Choose the corner from which rearranged shapes will be placed. 
Nesting will begin in that corner and extend across the plate size.

□□ Directions: The direction in which shapes will be nested across the material.
□□ Rotation: Allow rotation of  shapes by the specified maximum number of  degrees. If  

20 degrees, then shapes will be rotated in increments of  20 degrees to find the optimum 
placement.

□□ Nesting Border: The minimum distance to maintain from the material edge.
□□ Clearance Between Objects: The minimum distance between shapes.
□□ Error Factor of  Clearance: For expert VisionPro users, a value that is used to adjust 

nesting based on the average shape sizes.
□□ Allow Mirrored Parts: Allow objects to be flipped horizontally or vertically during the 

nesting process.
□□ Keep Groups Intact: If  this option is off, then grouped shapes will be separated 

during the nesting process.

Error Factor of Clearance
During the nesting process, approximations are made that are based partly on the magnitude 
of  the shapes being nested. Setting a small Error Factor will produce more consistent 
spacing between the shapes, but at a cost of  more processing time. The following chart 
provides suggested Error Factor values, which are qualified by the broad categories of  Fine, 
Medium, and Coarse. The table is based on the average dimension (inches or millimeters) of  
the shapes being nested.

Shape Dimension Fine Medium Coarse
0 < Size < 100 0.1 0.2 0.5

100 < Size < 1000 0.2 0.5 1.0
1000 < Size < 3000 0.5 1.0 2.0

Size > 3000 1.0 2.0 5.0

Fig. 26 - Nesting controls available from the SmartBar.
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Badges
From the Layout menu, the Badges command is used to serialize text data. For example, 
badges are used to create name plates for doors, identification cards for employees, and 
adhesive labels for schematics.

From the Badge Setup dialog, the Plate fields indicate the Width, Height, and Margins 
that will be used when distributing the badges across the plate size. The Spacing fields, 
Vertical and Horizontal, indicate the amount of  space to maintain between badges.

The Page Preview shows how the badges will be distributed across the plate size. Badges 
can be arranged either vertically (top-to-bottom), or horizontally (left-to-right).

The Use Score Lines option is used to insert score lines between each badge, so as to 
improve the ease of  separating the badges after production. Use the Color picker to set the 
score line color.

Enabling the Use Plate option will limit each badge to a single plate size. If  the Use Plate 
option is enabled, then the margins will be cleared to zero.

Where the generated badges require more area than the plate size, then the Paging Tool is 
used to browse the additional plate sizes. The Paging Tool is at the bottom-right corner of  
the workspace.

Setting Plate Size and Margins
□□ When routing or engraving, it is recommended that the Height and Width be set to the 

exact dimensions of  the plate.
□□ When rendering a vinyl sign, set the Height and Width to match the page size of  the 

plotter.
□□ When cutting or plotting, set the margins equal to the cuttable area of  material, not 

necessarily the actual size.

The Number of  copies indicates the total number of  badges to be created. The Total 
Number of  Pages indicates the number of  plate sizes that are required to display the 
badges, and Max copies per page indicates the number of  badges that can be displayed per 
plate size.

If  the badge text has been applied with text compression, then the Compress Equally 
Over Copies option is available. Enabling this option will cause all badges to be evaluated 
to determine the maximum amount of  text compression required (if  any) to fit replacement 
text within the badge margins. For consistency, all badges will then be applied with an equal 
amount of  text compression.

The Replaceable Items / Text list displays all text shapes that are available for substitution. 
The text of  each item will correspond to the text that had been entered on the workspace. 
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Select the text objects that will undergo substitution. If  a text shape is not selected within 
this list, then no substitution for that text will take place.

The Replacement Data File contains the text that will be substituted for each badge. 
The order of  fields in the Replacement Data File should correspond to the order of  text 
shapes on the VisionPro workspace. This will allow the Badge Setup dialog to substitute 
text in the correct order.

Replacement Data File
Any text editor may be used to create the Replacement Data File. Within the text file, each 
line represents a set of  data for one badge. If  the badge has multiple fields, then each field 
must be separated by a delimiting character, such as a comma, a space, or a tab character. For 
example, tab-delimited data might appear as follows:

Text Field 1  [TAB]  Text Field 2  [TAB]  Text Field 3

Next to the Browse button, the drop-down list may be used to choose the delimiting 
character that is used in the text file.

If  there are more badges being created than there are sets of  data, then the extra badges will 
be filled with empty data.

Badges – Text Substitution
From the Badge Setup dialog, click OK to continue. If  one-or-more text fields were 
selected within the Replaceable Items / Text list, then the Text Substitution dialog will 
open. Each column represents one of  the items from the Replaceable Items / Text list. 
If  a Replacement Data File had been specified, then the column entries will be filled using 
data from that file. To type text, select a cell and type within the Edit Text field.

Within the Text Substitution dialog, a column (or range of  cells within a column) can 
be serialized. For example, click a column header to select all the cells within that column. 
The Serialize dialog will open, which is used to indicate the Start value for the series, the 
Increment value between each cell, and whether Number or Character values will be used.

The Start value may be either numeric, alphabetic, or alphanumeric. For alphabetic series, 
the ASCII character set is used. When badges have incremented through the entire ASCII 
character set, then subsequent badges will continue from the beginning of  the set.
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Serializing Data – Set Base
When serializing badge data, the Start field is used as the base value, to which the Increment 
is added for each subsequent badge. By highlighting only part of  the Start field data, the 
selection will be incremented, and unselected portions will remain constant. For example, 
suppose a series of  booth labels must be created for a trade show.

As in the screen shot (Fig. 27), the value “Booth A” is typed. Using the mouse, only the 
‘A’ was highlighted, and then the Set Base button was clicked. This indicates that the word 
“Booth” will remain constant, while the highlighted portion will be incremented for each 
badge.

Fig. 27 - Highlight the letter or number that 
will be incremented, and then click the Set 
Base button.
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Chapter 4

Importing Images

In This Section…
□□ Importing and exporting files
□□ Publishing to PDF
□□ Browsing Clip-Art
□□ Scanning and tracing images
□□ Aligning scanned images to a baseline
□□ Configuring a Digitizer Tablet

Importing Files
VisionPro supports a wide range of  commonly used file formats, such that you can work in 
the design environment that is most comfortable for you. The resulting design can then be 
brought into VisionPro for further output preparation.

The type of  file format determines the type of  data that can be contained within that file. 
For example, a bitmap (BMP) file contains image data, whereas a plotter file would contain 
vector data. Some file formats can contain both image and vector data.

From the File menu, choose Import. The Import dialog will open.

□□ When importing with the Merge option checked, the imported file will be added to the 
existing workspace objects. 

□□ If  the Merge option is unchecked, then the existing workspace objects will be deleted.
□□ For certain types of  files, the Customize button will become active in order to specify 

certain parameters for the given file type. For example, if  the Files of  type drop-list is 
set to Bitmap Files (*.bmp), then the foreground and background of  monochrome 
bitmaps can be set.

□□ The Filter button is used to customize the file types that are listed within the Files of  
type drop-list.

 

After a file has been chosen for importing, one-or-more further import options dialogs will 
query how elements of  the given file should be imported. The import options will vary 
according to the type of  file being imported.

The VisionPro Help File contains more information about how to import the following file 
formats:
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CADlink Formats
□□ CADlink (CDL) Files
□□ CADlink Backup (BAK) Files

Common Formats for Images
□□ Bitmap (BMP) Files
□□ JPEG Files
□□ TIFF Files
□□ Adobe PhotoShop (PSD) Files

Common Formats for Line Art and/or Images
□□ Adobe PDF Files
□□ Adobe Illustrator (AI) Files
□□ Adobe Encapsulated PostScript (EPS) Files
□□ AutoCAD (DXF) Files
□□ CorelDraw (CDR) Files

Alternative and Legacy Formats
VisionPro supports a broad variety of  alternative and legacy file formats, which will convert 
the file objects into native VisionPro objects. In this manner, designs from older third-party 
or discontinued software packages (or older versions of  Windows) can be reused. 

Note: VisionPro does not include an import filter for the AutoCAD (DWG) file format. 
Instead, export from AutoCAD using the DXF format, and then use the “AutoCAD DXF” 
format when importing into VisionPro.
VisionPro does include DWG import filters for GraphicCAD, GenericCAD and MonuCAD. 
When importing such DWG files into VisionPro, take care to indicate the correct import 
filter (e.g., GraphicCAD *.DWG).

Exporting Files
Note: For comments about common file types, see Importing Files in the Help File.

 

To send a design to another VisionPro user, it should be sufficient to save (File menu >> 
Save) the design in CDL format. Alternatively, there are four methods of  exporting from 
VisionPro:

□□ File menu >> Save Embedded File – For designs that have linked images (e.g., using 
the Pattern Fills tool), save all such linked images as embedded images. The resulting 
size of  the CDL file will be increased, thought it can now be sent to another designer 
without worrying about broken links.
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□□ File menu >> Export – Use this method to save in file formats that store both images 
and cut paths (i.e., EPS files, AI files, etc.), or that support only cut paths (i.e., DXF 
files).

□□ File menu >> Export Image – Use this method to save in file formats that support 
only images (e.g., BMP files, JPEG files, TIFF files, etc.). The Export Image dialog will 
prompt for the Color Depth and Resolution at which the image will be exported.

□□ File menu >> Publish to PDF – Use this method to save the workspace as a PDF file 
that can be sent as a proof  to the customer.

Minimizing Object Nodes when Exporting
In the lower-left corner of  the Export dialog is the Customize button, which can be clicked 
to open the Parameter Specification dialog. The available controls on this dialog vary 
according to the file type, though generally this dialog is used to specify the export error 
tolerance.

As a rule, the default error tolerance (0.001 or 1/1,000 of  an inch) will work well with most 
files to reduce the number of  exported object nodes. However, if  the default values are 
insufficient, then a caution is urged against setting a high error tolerance.

Clip-Art
From the Layout menu, choose the Clip Art Viewer to browse the clip-art that was 
installed from the CADlink Fonts & Sign Clip-Art CD. Either bitmap (.BMP) or CADlink 
Drawing files (.CDL) are valid formats that may be imported as clip art.

Scanning Artwork 
From the File menu, the Acquire Image command is used to scan images from an attached 
scanner. Before using this command, the scanner and scan software must already have 
been installed. For more information about using the scanner software, consult the scanner 
software documentation.

As a suggestion, set your scanning software to scale the artwork by a large amount, such as 
an increase of  1000% (one thousand percent). This will provide a more detailed image that is 
easier to work with in VisionPro.

If  the scanned artwork is of  low quality, then it may be desirable to use a low dpi when 
scanning (say 75 dpi). Otherwise, a high dpi will merely magnify any mistakes that are in the 
artwork.

Where there is more than one scanner, the Select Source command is used to choose 
between the available scanners.

The Acquire command will activate the scanner software in preparation for scanning the 
artwork that is on the scanner bed. 
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The Acquire Vector command is similar to the Acquire command, except that it will load 
the artwork into VisionPro as vector artwork.

The Scan and Trace Wizard provides a series of  wizard steps that guide you through the 
process of  bringing an image into VisionPro and then tracing that image into vector artwork.

Note: See also Vectorize Wizard in the index.

When tracing scanned artwork, use a low Tolerance setting to avoid creating a large number 
of  nodes.

After tracing is complete, the resulting shapes are grouped. To node edit these shapes, 
perform an Ungroup command, and then apply a Make Path operation. The resulting 
shape can then be node edited.

Setting the Allowable Error
Under the Arrange menu, the Convert to Curves command is used to convert line art into 
bézier curves. Once converted into béziers, the line art should scale more smoothly. When 
converting, set the Allowable Error to one-hundredth (1/100) of  the smallest dimension of  
the shape. 

1.	 Suppose the line art measures 8 by 14 inches.
2.	 Units do not matter, so just take the smaller value (8), and divide by 100.
3.	 Therefore, the error should be 0.08 .

Align To Baseline
From the Layout menu, the Align To Baseline command is available from the Arrange 
and Distribute flyout.

For images that are scanned into VisionPro, it may be the case that the objects are slightly 
misaligned with the plate size. The Align to Baseline feature allows these objects to be 
aligned to either the horizontal or vertical plane. In addition, images can be aligned to a 45 
degree angle, or a custom angle may be set.

Before performing the alignment, a line must be defined along the edge the image. To define 
this line, two points must be set. Clicking within the workspace will set the first point (the 
point of  rotation), and clicking again will set the second point (the snap point). When a 
snap angle is applied, the line will be aligned to match the indicated angle, and the image will 
remain aligned with the line.

Digitizing Tablets
From the Edit menu, the Digitizing Setup… command is used to configure a digitizing 
tablet.
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Though no other intermediary software drivers are required for the tablet to be used with 
VisionPro, please ensure that the tablet is correctly connected to the computer, according to 
the manufacturer instructions.

The Enable Digitizer option is used to enable and disable the digitizer. In order to reduce 
the load on the system, it is recommended that the digitizer be disabled when not in use. 
This will prevent VisionPro from polling the tablet, and therefore free up system resources.

The Track Pen option is used to enable and disable the tracking of  the digitizing pen. In 
order to reduce the load on the system, it is recommended that the pen be disabled when not 
in use.

The Reset Baseline option is used when starting a new drawing, or if  the original angle and 
position of  the tablet baseline need to be restored. The baseline of  the tablet will be reset to 
match that of  the material.

The Set Baseline option is used to align the baseline in VisionPro with that of  the artwork. 
This avoids the requirement that the artwork be precisely aligned with the bottom of  the 
tablet.
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Chapter 5

Editing Bitmap Images

In This Section…
□□ Setting memory resources for Undo
□□ Types of  images (Image Mode)
□□ Creating bitmap images from line art
□□ Applying three-dimensional chiseled or beveled patterns
□□ Resizing images using the Super Size tool
□□ Easy image clipping with Fluid Mask
□□ Applying color adjustments, filters and plug-ins
□□ Editing images with AccuScan
□□ Vectorizing images into line Art
□□ Photo manipulation using GIMP
□□ Using PhotoMachine to line-trace an image

Setting Undo Resources
Before we get started with editing bitmap images, we should highlight the fact that large 
images can require quite a bit of  your workstation memory and hard drive space. This is 
particularly significant with respect to performing Undo operations to backtrack over your 
bitmap editing. If  the number of  Undo steps (and their required memory) exceeds the 
allocated resources, then older Undo steps will be discarded.

If  you want to have more resources available for your Undo operations, then from the 
VisionPro Options menu, choose VisionPro Setup >> Undo Setup. 

Scratch Disk Memory
The total amount of  Undo Setup memory is the sum of  your workstation memory and 
its available hard drive space. Knowing this limit, you have the freedom to increase the 
maximum amount, while keeping in mind that you want to leave enough resources for other 
applications. As such, this is a personal judgement call, but you can generally increase the 
maximum a certain amount, and if  you are finding that there aren’t enough undo when 
working with your bitmaps, then increase the maximum amount again.
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Types of Images (Image Mode)
There are five image types available for image editing: CMYK, RGB, Grayscale, Indexed 
Color, and Monochrome. To change the type of  bitmap in VisionPro, use the Image menu 
>> Mode flyout.

□□ The CMYK type is typical of  subtractive color mixing (i.e., printed images). This mode 
is used where specific CMYK values are envisioned for a design, and it is desirable to 
avoid possible rounding differences that might occur when printing RGB images (i.e., 
converting RGB to CMYK when printing).

□□ Under Windows, the RGB type has the highest color depth, and as such is often 
referred to as a full-color bitmap, a 24-bit bitmap, or an image that has “millions of  
colors.

□□ Converting a bitmap to Grayscale will discard all the color information within the 
image. Converting to grayscale is a common activity when tracing an image into cut 
paths, or when preparing an image for laser engraving.

□□ To reduce file size, bitmaps are sometimes saved as Indexed Color bitmaps, which can 
appear more granular because the total number of  colors are limited to either 256 or 
16 colors. As such, indexed color bitmap are not commonly used with high-resolution 
images , unless a particular effect is desired.

□□ For Monochrome bitmaps, note that Windows defines a monochrome bitmap as a 
two-color image, where white is the default background color, and black is the default 
foreground color. However, these defaults can be modified via Options menu >> 
VisionPro Setup >> Import Bitmap Setup.

Rendering Bitmaps
From the Transform menu, the Render to Bitmap command is used to convert a shape 
into a rectangular bitmap.

When the bitmap is created, empty portions of  the bitmap will be set to white. However, 
AccuScan can be used to make the white transparent.

Transparent Bitmap Background
1.	 Suppose that a bitmap has a white background that needs to be set as transparent.
2.	 Double-click the bitmap to enter AccuScan mode.
3.	 Above the Palette button, set the Target Color to white.
4.	 Press [Ctrl] and then left-click the Target Color.

From the Transform menu, the Render Contour Bitmap command uses process colors to 
create three-dimension chiseled or beveled patterns. The Constant Slope option will cause 
the chisel/bevel effect to reach its maximum height/depth at the same rate. For areas of  
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the bitmap that have a short distance between the edge and center, the bitmap will tend to 
plateau. The Constant Height option will cause the chisel/bevel effect to dip/peak along 
the centerline of  the shape. 

Resizing Images
On the VisionPro workspace, images are treated like objects that can be resized according to 
the job requirements. However, resizing will not change the image resolution. To increase the 
image resolution, either use the Image Size or Super Size Image commands.

Image Size
From the Image menu, the Image Size command displays size and resolution parameters 
for the selected bitmap. The Pixel Dimensions refers to the on-screen image size listed in 
pixels. The Resolution is listed in pixels per inch (i.e. like dpi or dots per inch). The Image 
Dimensions are the actual size at which the image will be printed or cut, expressed in the 
current ruler units.

Super Size Image
From the Image menu, the Super Size Image is similar to Image Size, except that more 
processing time is required to retain the detail quality of  the original image.

1.	 On the VisionPro workspace, scale the image to the desired print dimensions.
2.	 From the Image menu, choose Super Size Image.
3.	 Set the desired resolution quality of  the image.
4.	 Click Apply, and the Zoom Engine dialog will open.

(If no change in resolution has been specified, then clicking Apply will be ignored.)
5.	 Adjust the Zoom Engine controls to retain the desired quality, and then click OK.
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Fluid Mask - Easy Image Clipping

Note: Fluid Mask is an add-on feature that can be purchased for use with VisionPro.

Fluid Mask is an intuitive tool for knocking out the background of  an image, such as a 
photo of  a person standing before scenery. The process is very much like a paint-by-
numbers coloring book, where you paint with a green brush (the Keep brush) to indicate the 
foreground, and paint with a red brush (the Delete brush) to indicate background.

Suppose that you have a customer photo, such as a JPEG image of  their child that was taken 
using a digital camera (see Fig. 28). However, the background of  the image is cluttered and 
needs to be clipped using Fluid Mask.

1.	 Import the image onto the VisionPro workspace, select it, and then choose Image 
menu >> Fluid Mask.

2.	 The Fluid Mask editing mode will launch, and the image will be analyzed in order to 
automatically identify similar regions of  color and texture.
Several seconds may be required, and the resulting regions will appear much like a 
paint-by-numbers coloring book.

3.	 Along the top of  the Fluid Mask window are three tabs: Source, Workspace, and Cut-
out. The Workspace tab should be active.

4.	 On the left-hand side is the Tools toolbar.
5.	 From the Tools toolbar, choose the Delete Local Brush tool (Fig. 29).
6.	 With this brush, move the cursor over part of  the background image and then left-click.

Notice that regions that were overlapped by the brush have now been filled with a red 
mask.

Fig. 28 - Using Fluid Mask: (a) the original image, (b) after 
Fluid Mask has identified common regions, and (c) the 
finished image with clipped background.
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7.	 Continue to click other portions of  the background, such that you are filling in the 
background with a red mask (i.e., this portion is being marked for deletion).
In addition to clicking, you can also click-and-drag to paint over an area.

8.	 If  necessary, remove the tick from the Show Object Edges checkbox. This will hide 
the regions, such that you can distinguish any portions of  the background that were 
missed.

9.	 When you have finished painting the background red, choose Image menu >> Auto-
Fill Image.
The foreground of the image will be automatically painted green (i.e., the foreground 
will be kept).

Also, a blue blending line will automatically indicate the transition region between red 
background and green foreground.

10.	 From the Tools toolbar, click the Create Cut-Out button.
11.	 From the File menu, choose Save And Apply.
12.	 The Fluid Mask window will close, and the view will return to VisionPro.
13.	 The Prime dialog will query whether a primer should be automatically applied to the 

image. For the sake of  this example, choose No and click Close.
14.	 The resulting image with clipped image will be placed on the VisionPro workspace.

Fig. 29 - From the Fluid Mask Tools toolbar, use 
the Delete Local Brush tool for painting the red 
background mask.
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Fluid Mask Comments

Green for foreground, Red for background
□□ In our example, we used a red brush to paint the background mask, and then we used 

Image menu >> Auto-Fill Image to automatically complete the foreground mask.
□□ Depending on the image, we may have found it easier to use a green brush to paint the 

foreground mask, and then use Auto-Fill Image to complete the background mask.

Local Brush and Exact Brush
□□ For both green and red, there is a Local Brush and an Exact Brush.
□□ Use the Local Brush to paint regions.
□□ Use the Exact Brush to paint only pixels (i.e., this is a fine editing tool).

Increase the brush size
□□ Use the square bracket keys ‘[‘ and ‘]’ to change the brush size.

Increase the brush strength
□□ A brush with strength zero will affect only the regions that you touch with the brush.
□□ A strength greater than zero will cause adjacent regions to be painted (e.g., like a damp 

brush).

Use the Clean Tool
□□ After most of  a background or foreground mask has been filled, choose the Tools 

toolbar >> Clean Tool, and then click the given mask. Any speckles within the mask 
will be automatically painted.

Hide the Region Edges
□□ Along the bottom of  the Fluid Mask window is the Show Object Edges checkbox. 

Remove the tick to reveal missed areas.

Undo the Paint Steps
□□ If  you have painted the wrong portion of  the image, then use the Edit menu >> Undo 

command. The shortcut for Undo is [Ctrl + z].
□□ Alternatively, from the Tools toolbar, use the Erase Brush (there are both Local and 

Exact versions).

Zoom 
□□ Press the ‘z’ key to activate the zoom magnifying glass, then marquee-select the zoom 

region.
□□ To see the full size image, use the [Ctrl + 0] shortcut (control + zero).
□□ Use the ‘+‘ and ‘-’ keys to zoom in and out.
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Image Menu - Color Adjustments
From the Image menu, there are flyouts for both Easy Color Adjustments, and Color 
Adjustments. The Easy Color Adjustments are automated settings that can be used 
to quickly improve image quality. For greater control over the image, use the Color 
Adjustments flyout.

Easy Color Adjustment tools:
Note: These tools can be applied multiple times to achieve the desired effect.

□□ Cleanup Black - Improve the contrast (i.e., appearance of  details) within dark regions 
of  the image.

□□ Cleanup White - Improve the contrast (i.e., appearance of  details) within light regions 
of  the image.

□□ Make Lighter - Reduce the depth of  shadows within the image (e.g., increase the 
brightness).

□□ Make Darker - Tone down the highlight regions of  the image (e.g., improve details in 
the light portions).

□□ Increase Saturation - Strengthen the distinct hues within the image.
□□ Blur Image - Soften details within the image.
□□ Sharpen Image - Increase the contrast of  details within the image.

Color Adjustment tools:
□□ Levels – Adjust the distribution of  color intensities throughout the bitmap, either to 

correct a scanned image, or to create an artistic effect.
□□ Contrast/Brightness… – The Contrast setting is used to modify the perceived 

difference between light and dark areas of  the bitmap. The Brightness setting is used 
to modify the overall intensity of  the bitmap.

□□ Hue/Saturation… – Adjust the Hue, Saturation, and Lightness values of  the bitmap.
□□ Curves… – Adjust the tonal range (shadows, midtones, and highlights) of  the bitmap.
□□ Invert – Inverts the colors in the bitmap, making it like a photographic negative. This 

feature can also be used to invert the color of  a grayscale image, making the black white 
and the white black.

□□ Posterize… – Limit the number of  color levels per plane (red, green, and blue). For 
example, two levels means two of  red, two of  green, and two of  blue.

□□ Histo Contrast… – Increases or decreases the contrast of  the bitmap image, using a 
histogram to determine the median brightness. Once the median brightness has been 
determined, pixel values above the median are brightened, and pixel values below the 
median are darkened.

□□ Stretch Intensity – Increase the color contrast in the bitmap without changing the 
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number of  discrete intensity values (ordinary contrast adjustments can lose high- and 
low-end values).

□□ Histo Equalize – Linearizes the number of  pixels in the bitmap, based on the specified 
color space (RGB, Grayscale, etc.).  This can be used to bring out detail in dark areas of  
an image.

□□ Balance Colors… – Redistributes the RGB values of  individual bitmap pixels. For 
each pixel, its red, green, and blue components are isolated, and the color sliders are 
then used to increase or decrease the percentage RGB values within each pixel. In this 
manner, a color cast can be removed from the bitmap, or a color tinge can be created 
for an artistic effect.

□□ Swap Colors… – Swap the color channels of  the original bitmap. This feature is useful 
for obtaining artistic effects that would otherwise be difficult to achieve using the other 
Color Adjustment tools.

Image Menu Filters
From the Image menu, the Filters flyout provides a selection of  effects that can be applied 
to bitmap images.

Sharpen filters:
□□ Sharpen – Increase or decrease the sharpness of  the bitmap.
□□ Unsharp Mask – Despite its name, this is actually a sharpening function because it 

increases the contrast between light and dark areas of  the bitmap. Wherever there is a 
brightness transition between light and dark, the light area is made lighter, and the dark 
area is made darker, such that the transition becomes more distinct.

Blur filters:
□□ Average – Changes the color of  each bitmap pixel to the average color of  pixels within 

the surrounding pixels. This results in a blur effect.
□□ Gaussian Blur – Smooth or blur pixels with respect to their surrounding pixels. The 

Radius determines the surrounding area that is considered when blurring a pixel.
□□ Motion Blur – Blur the bitmap to create the illusion of  movement within the image. 

Positive angles indicate a clockwise blur, and negative angles indicate a counter-
clockwise blur.

□□ Median Filter – Changes the color of  each bitmap pixel to the median color of  pixels 
within the surrounding pixels.
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Noise filters:
□□ Add Noise – Add random pixels to the bitmap. Adding noise can be an effective 

means of  making an image appear older or dirtier, especially where the purpose is to 
distract the eye from imperfections in the original image.

□□ Despeckle – Removes speckles from the bitmap, such as those present in scanned 
images.

Stylize / Artistic filters:
□□ Emboss – Applies an emboss effect to the bitmap, letting you specify the depth and 

direction of  the effect.
□□ Solarize – Creates an effect that mimics the accidental exposure of  photographic film 

to light. This is done by inverting all color intensities that exceed the Threshold value.
□□ Oilify – Create an oil-painting effect. For each pixel, the Amount indicates the number 

of  surrounding pixels that are considered when creating the effect.
□□ Mosaic – Create a mosaic effect by dividing the bitmap into tiles of  the specified size, 

and then averaging the pixel colors within each tile.
□□ Spatial Filter – An assortment of  artistic filters.
□□ Halftone – Converts a bitmap with any resolution to a halftoned bitmap. A halftoned 

bitmap is a 1-bit bitmap that has been dithered for black and white printing or display.
□□ Intensity Detect – Set all pixel color intensities to 255, or clear them to zero. If  a 

pixel’s intensity is between Low and High, then set the intensity to 255. Otherwise, clear 
the intensity to zero.

Remove Red Eye
□□ Removes the “red eye” effect that results from flash photography. For each pixel, only 

the red color component is evaluated.
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Image Menu Plug-In Filters
Plug-ins are software modules that are used to create special effects for bitmaps. These 
modules may be obtained through either Adobe or third-party plug-in developers.

After plug-ins have been installed on your computer, go to VisionPro and use Image menu 
>> Options >> Plug-In Paths to indicate the hard drive location of  the plug-ins. The 
plug-ins will then be available under the VisionPro Image menu.

Note: Some plug-ins require that a foreground and background color be set. In this case, 
use the Set Foreground Color and Set Background Color commands.

The Plug-ins Helper Dialog
Whereas plug-ins are typically designed only for bitmaps, VisionPro can also apply plug-ins 
to line art, or to a combination of  line art and bitmap objects (Fig. 30).

By using line art as the basis for your plug-in effect, the resulting effect can be clipped to the 
line art.  In this way, the following advantages are obtained:

1.	 The “empty” portions of  the plug-in bitmap are usually set to a white color, which 
are undesirable when arranging the bitmap with surrounding objects. Clipping to the 
original line art will hide the empty portions of  the bitmap.

2.	 The bitmap that is produced by the plug-in will often have a jagged edge, which will 
look poor when scaled up to a large poster size. Clipping will “trim” the jagged edge, 
such that scaling is acceptable.
Note: A good alternative to case (2) is to scale your original line art to the desired size 
before applying the plug-in effect. Line art shapes will scale without diminishing their details.

Fig. 30 - When plug-ins are applied to 
line art, the Plug-ins Helper dialog is 
used to define how the effect will be 

applied to the line art.
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Plug-ins: Richard Rosenman™ Collection
Note: More about Richard Rosenman’s work can be read about here: www.
richardrosenman.com/profile/biography

VisionPro includes four plug-ins from Richard Rosenman. The plug-ins are available from 
the Image menu >> Richard Rosenman flyout. The available plug-ins are:

□□ Diffuse Glow – Produces an almost angelic glow.
□□ Lens FX – Produces an assortment of  distortion effects, as would be possible using a 

camera lens.
□□ Pinch – Similar to using Lens FX to create a pinch effect, except there is greater 

control over the vertical and horizontal distortion.
□□ Scanlines – Creates horizontal or vertical lines that can suggest transitions or images 

viewed on a low-resolution video display.

Plug-ins: Redfield™ Collection
Note: More Redfield plug-ins are available through the Redfield web site: www.
redfieldplugins.com

VisionPro includes five plug-ins from Redfield. The plug-ins are available from the Image 
menu >> Redfield flyout. The available plug-ins are:

□□ Craquelure 3D – Creates a variety of  texture effects.
□□ Jama 3D – Creates corrugated and cellular patterns.
□□ Lattice Composer – Creates grids and weave patterns.
□□ Seamless Workshop – Creates seamless tiles.
□□ Water Ripples – Creates a variety of  water ripples effects. 
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Plug-ins: Harry’s Filters™
Note: More of  this type of  plug-ins are available through the Plugin Site: www.
thepluginsite.com

VisionPro includes sixty-nine (69) plug-ins that are available through a single dialog interface. 
From the Image menu, choose The Plugin Site >> Harry’s Filters. The available plug-ins 
are:

Color
□□ Add Color – Adjust the RGB color channels within the image.
□□ Cartoon Art – Assign an off-tone pallor that suggests an artist’s rendition.
□□ Colorize – Vary the image hues as if  the image were based upon a monotone print.
□□ Color Mood – Introduce sharp color contrasts.
□□ Color Wizard – Like Color Mood, except with pastel color contrasts 
□□ Expose – Create over- and under-exposure effects that are reminiscent of  developed 

film.
□□ Twilight Colors – Sombre mood that suggests dim lighting (e.g., dawn or dusk).
□□ Old Film – Simulates the graininess of  film that has begun to deteriorate due to age.
□□ Inversity – Stark hues that suggest the presence of  overhead lighting.

Artistic
□□ Atmospherizer – Rotate the spectrum of  colors as if  the image were being viewed 

through a transparent color sheet of  plastic film.
□□ Blurry Painting – Present the image as if  it were a watercolor or composed of  paint 

daubs.
□□ B/W Limiter – Attenuate the color values within the image to emphasize its grayscale 

components.
□□ B/W Limiter Pro – Combine a grayscale with hints of  color from the original image.
□□ Color Cocktail – Emphasize kaleidoscopic transitions and color shifts.
□□ Crochet Art – Superimpose the image with a pattern that suggests the texture of  

knitted cloth.
□□ Equalizer – Suppress color values to produce a more subdued image.
□□ Equalizer Pro – Suppress color values to emphasize certain hues from the original 

image.
□□ YUV Intensity – Adjust the image in terms of  YUV color model. Tends to produce 

pastel colors with stark contrasts.
□□ Color Compress – Produce a posterized appearance with intense hue shifts.
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Gradients
□□ Beam – Subject the image to a strong light source.
□□ Chaos – Introduce sporadic shading throughout the image.
□□ Double Sphere – Apply a color distortion that exudes from the image center.
□□ Frame – Border the image with the appearance of  vertical color strips that convey a 

sense of  change or progress.
□□ Mixed Beam – Overlay the image with filtered colors, as if  there were multiple color 

light sources.
□□ Mixed – Shift color regions within the image as if  it were the product of  a complex 

screen print.
□□ Mystic Mountain – Apply colors with a dream-like quality.
□□ Quad Beam – Burnish the image as if  it were subjected to sources of  strong white 

light.
□□ Star – Burnish the image as if  it were subjected to an intense source of  white light.
□□ Spirals – Superimpose concentric circles that suggest disorientation or activity.
□□ Triple – Intense hues of  vertical bands or concentric circles.

Patterns
□□ Radial Sinality – Explosive rays or bands of  varying amplitude that convey energy and 

inspiration.
□□ Sinfinity – Suggestive rays or bands of  varying hues and amplitude.
□□ Rasper – Overlay curves and patterns like images from a contemporary fashion 

magazine.
□□ 70s Pop – Overwhelm the image with a storm of  multiple color light sources.
□□ Random Art – Intense rays or bands that suggest mood and transition.
□□ Symbol Shaper – Horizontal bands that suggest vision and realization.

Warp
□□ Wonderland – Ripple the image like water distortion or waves of  heat.
□□ Tiled Glass – Divide the image into blocks of  glass.
□□ Swirl – Ripple the image like a sheet that is being blown by a rotating fan.
□□ Picture Chopper – Ripple the image like a sail that is blowing in the wind.
□□ Glass Slices – Subdivide the image into fragments or slivers of  glass.
□□ Kamikaze – Rotate and zoom the image.
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Noise
□□ Circular Noise – Create static like a television that is experiencing poor reception.
□□ Grain Maker – Introduce a posterization that provides the image with a textured 

appearance.
□□ Nail Art – Superimpose a lattice of  curved patterns.
□□ Noisy Blur – Distort the image as if  it were being viewed underwater or from behind a 

panel of  thick glass.
□□ Noise Reducer – A simple noise reduction filter for imported images.
□□ Digital Cutter – Divide the image into vertical barcode-like line segments, imposing 

the idea of  digital static.

Encrypt/Decrypt
□□ Black and White – Combine up to eight (8) noise channels to produce a convoluted 

amalgam of  the image.
□□ Color – Vary each pair of  sliders (Key 1 and 2, Key 3 and 4, etc.) to resample the color 

regions of  the image.
□□ Moiré Decryption – Introduce posterization and static that suggest corrupted image 

data.
□□ Moiré Encryption – Introduce posterization and static that suggest corrupted image 

data.
□□ Noise – Combine up to eight (8) noise channels.
□□ Radial – Subdivide the image into concentric sections that suggest a high-technology 

cyberpunk theme.
□□ Sinus – Apply short horizontal bands of  noise.
□□ Weak – General soft background noise, as would be caused by a loose connector on a 

security monitor.

Other
□□ Convolver – Varying emboss effects that highlight details in the image.
□□ File Size Reducer – Discard image data, though at the risk of  losing image detail.
□□ Overpainting – Overlay additional color layers like rough paint strokes.
□□ Quadrant Flip – Divide the image into four quarters, and then rotate the sections.
□□ Streamer – Create vertical or horizontal motion blur lines.
□□ Zoom – Magnify a circular portion of  the image.
□□ Convolver Pro – Advanced emboss effects that highlight details in the image.
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Nature
□□ Dawning – Imbue the image with a light source that suggests a rising sun.
□□ Flame – Create flame lines along bottom of  image.
□□ Lightning – Place jagged diagonal lines to simulate a flash of  lightning.
□□ Polar Lights – Simulate the presence of  Christmas lights.
□□ Super Nova – Classic transition effects from science fiction movies.
□□ Tornado – Overwhelm the image with the appearance of  high winds and debris.

Plug-ins: Alien Skin™ Sampler
Note: More Eye Candy plug-ins are available through the CADlink store: www.cadlink.com/
store

VisionPro includes five plug-ins from Alien Skin. The plug-ins are available from the Image 
menu >> Eye Candy 4000 flyout. The available plug-ins are:

□□ Bevel Boss – Creates carved, embossed or bevel surface texture.
□□ Chrome – Create a reflective embossed effect that simulates chrome and other shiny 

surfaces.
□□ Corona – Projects a halo effect that projects from behind the selection.
□□ Gradient Glow – Create soft glows or hard outlines around the selection.
□□ Shadowlab – Create drop, perspective, and cast shadows.

Plug-ins: CADlink Collection
In addition to the third-party plug-ins, CADlink provides a new set of  in-house plug-ins, 
which are available through the Image menu >> CADlink flyout. The available plug-ins 
are:

□□ Lighting Effects  – Combine up to six (6) distinct light sources to create the effect of  
artificially illuminating the image.

□□ Posterize – Resample the image according to discrete color regions, as would be used 
when creating color separations.

□□ Sphere Effects – Introduce one-or-more distortions that simulate raised sphere 
surfaces.

□□ Tilt Effects – Change the image perspective to create the sensation of  depth.
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Bitmap Editing Using AccuScan
From the Scan Tools flyout, the AccuScan tool is used to edit bitmaps. Double-clicking a 
bitmap will also activate the AccuScan editing mode. The AccuScan tools (Fig. 31) may then 
be used to edit the bitmap, apply filters and plug-ins, and convert the bitmap into a line-
traced drawing format.

Selection Tools
When creating a selection, the [Shift] key may be used to extend the previous selection. In 
addition, the [Control] key subtracts from the previous selection.

□□ Whole Bitmap: Select the entire bitmap
□□ Ellipse Select: Select an oval area
□□ Rectangle Select: Select a rectangular area
□□ Draw Lasso: Select a freehand area
□□ Draw Select: Define an area that has an irregular shape
□□ Eyedropper: Pinpoint a color in bitmap and add it to the Shop Palette
□□ Palette: Select regions based on specific colors. Colors may be either added or 

subtracted from the current selection.
□□ Magic Wand: Select region based on similar colors. The Magic Wand setup may be 

used to customize what is considered to be “similar.”

Applying Filters and Plug-Ins
When in AccuScan editing mode, the Image menu Color Adjustments, Filters, and Plug-Ins 
can all be applied to bitmaps. If  only part of  the bitmap is selected, then the effect or filter 
will only be applied to the selection.

Fig. 31 - AccuScan controls within the SmartBar.
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Bitmap Palette Colors
Click the Palette button to display the current colors in the bitmap palette. The Image 
Palette dialog may be used to select palette colors and move them to the front or back of  
the palette.

If  there is not enough space in the palette for new colors, then use the Merge Colors tool 
to reduce the number of  palette colors.

Transparent Bitmap Color
Above the Palette button is the current Target color. The target color is used with the 
Brush and Fill tools.

The target color can be set to be transparent by pressing the [Ctrl] key and then left-clicking 
the Target color (Fig. 32).

Bitmap Manipulation Tools
The bitmap editing tools are summarized as follows:

□□ Brush – Edit the bitmap using the Target color.
□□ Move Region – Copy the selection and move it to a new location. Press [Ctrl] to fill 

the old region with the Target color.
□□ Crop Tool – Trim the bitmap to the selected area.
□□ Fill Region – Fill the selected area with the Target color.
□□ Quarter Bitmap – Reduce the resolution of  the bitmap by 50% in terms of  its width 

and height.
□□ Extended Information – Display information concerning the dimensions and 

resolution of  the bitmap.
□□ Merge Colors – Used to remove all unused colors from the bitmap palette, and to 

replace selected colors in the Image Palette dialog with the Target color.
□□ Posterize Region – Generating a color palette for a bitmap where none exists, or 

expand/reduce the size of  the bitmap palette.

Fig. 32 - Transparent color controls in AccuScan.
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How to merge palette colors
1.	 Use the Posterize Region tool to reduce the number of  colors in the bitmap to 256 or 

less.
2.	 Beneath the Target color, click the Palette button.
3.	 The Image Palette dialog will open.
4.	 In the Image Palette dialog, click two-or-more colors, such that they have white 

borders.
5.	 Click the Merge Colors button, and the selected colors will be set to the Target color.

Vectorizing Images into Line Art
VisionPro provides two methods of  vectorizing an image into line art. The classic 
vectorization method provided leading-edge tools that were suitable for previous VisionPro 
users. The new method uses the Prepare to Vectorize Wizard, which introduces new tools 
for improving the image quality, knocking out the image background, and posterizing the 
image colors prior to tracing.

The Classic Vectorization Method
The classic method of  vectorizing a bitmap involved the Posterize Region and Merge 
Color tools to simplify the number of  colors in the image. The following is an overview of  
the classic vectorization method:

Posterize the bitmap
1.	 In AccuScan mode, click the Posterize Region tool. 
2. 	 A dialog will query whether the vectorize wizard should be used. Click No to use the 

classic method.
3.	 The Posterization dialog will query for the number of  colors to reduce the number of  

colors in the bitmap, such as 8 or 9 colors.

Merge similar colors
4.	 Beneath the Target color, click the Palette button to open the Image Palette dialog.
5.	 In the Image Palette dialog, click the similar colors, such that they have white borders.
6.	 Double-click the color these similar colors should be merged into. The Target color 

will be set.
7.	 Click the Merge Colors button, and the selected colors will be set to the Target color.

Vectorize the bitmap
8.	 At the far-right of  the AccuScan SmartBar, choose the vectorization settings from the 

drop-list.
9.	 Click the Vectorization button.
The bitmap will now be vectorized, and the resulting vector shapes will be grouped.
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The Prepare to Vectorize Wizard
This vectorization method uses the Prepare to Vectorize Wizard, which involves self-
contained steps for improving image quality, knocking out the image background, and 
posterizing the image colors prior to tracing. The following is an overview of  the Prepare to 
Vectorize Wizard steps:

Initial Wizard Settings
1.	 From the Image menu, choose Prepare to Vectorize Wizard.
2.	 The initial wizard page will query for Super Size and Image Background settings. Use 

the default amount of  memory, click Yes to use Fluid Mask, and click OK to continue.

Zoom Engine (Super Size)
3.	 The Zoom Engine dialog will preview the image at the higher resolution quality.
4.	 Click OK to accept the default Zoom Engine settings.

Fluid Mask
Note: If  the Fluid Mask tool is not available, then please skip to step (13).

5.	 The Fluid Mask window will analyze the color regions within the image, and thin 
irregular lines will be used to roughly identify each region.

6.	 Using the Delete Local Brush tool, click background regions of  the image, such that 
they background appears to be filled with red.

7.	 If  a portion of  the foreground is accidentally filled with red, then use Undo [Ctrl + z] 
to correct.

8.	 If  a portion of  the background is difficult to fill correctly, then use the Delete Exact 
Brush to manually paint the background by dragging strokes.

9.	 When the background has been filled with red, choose Image menu >> Auto-Fill 
Image. The background will remain red, the foreground will appear to be filled green, 
and a blue “blending line” will appear along the boundary between red and green 
regions.

10.	 Choose Image menu >> Create Cut Out. The image should now appear with the 
formerly red portions “knocked out.”

11.	 Use [Ctrl + s] to save the image back to VisionPro.

Import Options
12.	 The following import options will be provided when loading image data back into 

VisionPro:
□□ The Prime dialog will be available for applying either a primer and/or highlight to 

the image.
□□ The Transparent Threshold dialog will open. Click OK to accept the default 

value, which is used for controlling visibility of  image pixels.
□□ The Select Profile dialog will provide an opportunity to select a new color profile.
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Posterization
13.	 The Posterization dialog will now allow you to choose the colors that the image will be 

reduced to.
14.	 The top half  of  the dialog shows the original image before posterization. The bottom 

half  previews the posterization, where Color 1 is pure black by default.
15.	 Click Color 2 and then click a color in the original image.
16.	 Likewise, click Color 3 and choose another color in the original image.
17.	 Continue choosing colors, until the preview has enough colors to appear satisfactory.
18.	 Increase the tolerance for Color 1 (black), so that shades of  gray are accounted for.

Vectorization
19.	 Click OK to close the Posterize dialog, and the image is now ready to be vectorized.
20.	 Double-click the image to access AccuScan editing mode.
21.	 At the far-right of  the AccuScan SmartBar, choose the vectorization settings from the 

drop-list.
22.	 Click the Vectorization button. The bitmap will now be vectorized, and the resulting 

vector shapes will be grouped.
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PhotoMachine
The PhotoMachine tools are used to convert a bitmap into a line-traced drawing that can 
be cut, routed, or engraved.

PhotoMachine styles:
□□ None – Produce a grayscale bitmap
□□ Image Cut – For use with cutters only. Weeding lines for vinyl are produced, where 

thin bands represent light portions of  the bitmap, and thick bands represent dark 
portions.

□□ Wiggle – For use with low-resolution engravers. Creates a pattern that appears to 
wiggle across the image.

□□ Output Tool Paths – For use with low resolution engravers. Creates a standard 
engraving pattern.

□□ Squares – For use with cutters only. A pattern of  variable-sized squares is used to 
depict the image. Smaller squares represent light portions of  the bitmap, and larger 
squares represent dark portions.

□□ Stars – This style is similar to Squares, except that star shapes are used.
□□ Rain – For use with laser-engravers. Creates multiple “falling rain” lines for each pixel.
□□ Iron filings – This style is similar to Rain, except that all lines are created at random 

angles.
□□ 3D Image – Creates a 3D tool path based on the image. For devices that support 

depth control, the tool path may be used to render a three-dimensional relief  image on 
the loaded material.
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Chapter 6

Rotary Engraving

In This Section…
□□ Configuring the machine
□□ Adding Tools Paths
□□ Previewing the cut job
□□ Registration marks and cutter alignment
□□ Tiling jobs to fit media and machine limits
□□ Filtering cut shapes by color
□□ Recording the lifetime of  the cutting tool
□□ Estimating time required to complete the job
□□ Creating weed borders around script lettering

Updating Machine Drivers

File menu >> Install >> Cutting Devices

Windows Start menu >> All Programs >> VisionPro >> Cutting Device Installation

Before a given machine can be used, its software driver must be installed, which allows your 
computer to communicate with the machine. Once installation has been performed, the 
machine will be available via Engrave menu >> Engraving Defaults >> Selected Driver 
drop-list.

Updating Plotter Drivers
New and updated plotter drivers are posted to the CADlink web site as they become 
available. 

1.	 Go to the CADlink web site at www.cadlink.com
2.	 Select Downloads and Plotter Drivers, and then login when prompted.
3.	 Select the plotter manufacturer, the model, and the CADlink product version that you 

are using.

Note: The product version can be found via Help menu >> About VisionPro.
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Configuring the Machine

Engrave menu >> Engraving Defaults

Installation of  your VisionPro involved choosing the machines that would be available. For 
each device that was selected, the corresponding device driver was installed. A device driver 
is the software component that allows the workstation to communicate (i.e., send data) to 
the plotter or cutter.

Important Output Dialog Settings
1.	 Choose Engrave menu >> Engraving Defaults to open the Output dialog.
2.	 From the Output dialog, choose the Tool that will be used for plotting or cutting. For 

some cutters, the Tool setting refers to the set of  machine conditions that are being 
used, in which case the Operator’s Manual should be consulted for that cutter.

3.	 Click the Tool Options button to view feeds and speeds for the machine. For more 
information about the feed and speed parameters, consult the machine’s Operation 
Manual.

Setting Feeds and Speeds per the Material Type
The Tool Options dialog parameters can be set according to material type.

1.	 Choose Engrave menu >> Engraving Defaults >> Tool Options.
2.	 The Tool Options dialog for the machine will open, which displays the available feeds 

and speeds that can be set for the machine.
3.	 At the top-right of  the dialog, the Material drop-list is used to choose the default 

material that has been loaded into the machine.
4.	 Once the material has been selected, set the feed and speed parameters accordingly.

Important Engraver Setup Settings
1.	 Choose Engrave menu >> Engraving Defaults >> Setup to open the Engraver 

Setup dialog

2.	 On the Engraver Setup tab, verify that the Machine Limits are correct

3.	 On the Port tab, choose the method of  sending cut data to the machine:

□	 Direct to port – This will send the cut data to a machine that is attached to this 
workstation.

□	 Use Output Spooler – This is a legacy feature of  VisionPro that is kept available 
for seasoned VisionPro users.
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Creating Tool Paths

Engrave menu >> Create Tool Path

Tools toolbar >> Tool Path Tools

By default, newly created workspace shapes are treated like simple contour cut paths 
of  zero depth. To define more sophisticated machining paths, use the Tool Path Tools 
flyout (Fig. 33).

Online
Defines a basic cutting path for which the tool will follow the edge of  a designated 
shape (Fig. 34). The resulting cut will have an offset of  zero. The Online tool path is often 
used to trace shapes in artwork without filling the shapes with an engrave pattern.

Fig. 33 - Except for Drill, the tool paths can also be applied 
through Engrave menu >> Create Tool Path.

Fig. 34 - The Online tool path will trace the 
shape contour.
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Male
Defines a basic cutting path on a selected shape, such that the resulting cut shape will fit 
within a corresponding female shape (Fig. 35). The tool path will fall to the outside of  the 
shape contour, such that the offset equals one-half  of  the bit width. The Male tool path is 
typically used to cut shapes out of  a material.

Female
Defines a series of  cutting paths on a designated shape, such that the resulting cut shape 
may contain a corresponding male shape (Fig. 36). For example, consider a polygon shape 
that is cut using a Male tool path, thereby producing a male cut. Suppose then that the same 
polygon shape is cut using a Female tool path, thereby producing a female cut. The male cut 
will then fit within the inner contour of  the female cut.

Fig. 35 - The Male tool path will cut a shape 
that fits within a corresponding female shape.
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Fig. 36 - The Female tool path will cut a shape 
that contains a corresponding male shape.
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Fill
Defines a series of  cutting paths designed to remove material from inside a selected shape.

Note that when simply placing one object within another, a fill operation will engrave the 
outer object without consideration of  the inner object. The correct technique is to combine 
two such objects into a single path, and then the Fill tool path operation may be applied. 
The following steps show how this is done:

Assume that a text logo must be placed within a star shape, all of  which must then be filled 
without losing the text.

1.	 Create text for the logo. With the text selected, choose Arrange menu >> Text to 
Graphics. This will convert the text into a graphic for cutting.

2.	 Create a star shape that is large enough to contain the logo, and then center the text 
within the star.

3.	 With both the text and star selected, choose Arrange menu >> Make Path. Both 
objects will now have been combined into a single object.

4.	 Apply a Fill operation to the combined object. The result will be a filled star shape that 
correctly retains the text that was placed within it.

3D Chisel
Defines a cutting process that varies the depth of  a contour tool (usually a conical tool, or 
a V-bit) along the defined path.  The width of  the cut path varies with the depth of  the tool 
path. This type of  cutting is used to create a “hand carved” effect.

Drill
The Drill tool is used to place drill points upon the workspace. Simply left-click on the 
workspace to place a drill point. For a selected drill point, its Depth is editable from the 
SmartBar.

Drill Contour
The Drill Contour tool will lay a series of  drill points along the contour of  an object or 
group of  objects.

□□ Number indicates the number of  drill points that will be spaced evenly along the 
contour of  the selected object.

□□ Distance between points is used to space drill points evenly along the contour of  the 
object.

□□ Offset is used with the Distance option to indicate an initial gap before drill points are 
placed. After the gap, drill points will be spaced according to the Distance value.

□□ Nodes represent the coordinates that are used for rendering the object on the 
computer screen. Use this option to place drill points according to each node. This 
feature is especially useful when used with polygons.

□□ Nodes and Distance will begin by placing drill points according to each node of  the 
object. Additional drill points are then placed according to the distance.
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Drill Center
The Drill Center tool will place a drill point in the center of  the selected object. If  more 
than one object is selected, then a drill point will be placed at the center of  each object.

Previewing and Sending the Job

Engrave menu >> Output

Tools toolbar >> Output Tool

Engrave Preview mode will display the workspace shapes as they will be cut upon the 
material. The SmartBar displays the current cut settings, as per Engrave menu >> 
Engraving Defaults. The Cut Toolbox toolbar provides additional functions that can be 
applied to the job before cutting (Fig. 37).

Except where noted, any settings made using the SmartBar controls or the Cut Toolbox 
toolbar will not change the default values. Instead, such changes will only apply to the 
current job.

At the far-right of  the Cut Toolbox, click the Engrave button to send the job. Alternatively, 
if  elements of  the design have been organized according to color, then the Sort and Cut All 
Colors button can be used to control the order in which the design elements are output (See 
also Filter By Color).

Fig. 37 - Engrave Preview will summarize the machine, tool and material in 
the SmartBar. The Cut Toolbox provides additional operations that can be 
performed, including sending the job.
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Registration Marks
Registration marks are typically used in the following manner:

□□ Where multiple layers of  vinyl are being used to compose a sign fascia, create 
registration marks to help with alignment of  each layer.

□□ When loading printed media into the cutter, some cutter models have a sensor that can 
recognize the registration marks and align the job automatically. For cutters that do not 
include a sensor, the operator will be prompted to manually align the cutter tool with 
each registration mark.

□□ For a sheet a material, a registration mark can be used as a point of  reference that will 
be used to position subsequent jobs (see also Plotter Jog).

Locations of Registration Mark Tools
A.	 From the Shape Tools flyout, the Registration Mark tool is used to manually place 

registration marks about the artwork.
B.	 From the Shape Tools flyout, the Multi-Registration Mark tool is used to manually 

offset registration marks about the artwork.
C.	 In Engrave Preview mode, the Cut Toolbox has a Registration Mark button. Right-

click the Registration Mark button to choose the position, size, and offset of  the 
registration marks. Left-click the Registration Mark button to place the specific type 
of  registration marks.

Plotter Jog
Plotter jog is the ability to position the cutter head by using the Jog dialog controls in 
VisionPro. This feature is typically used to reduce wasted material by cutting new shapes 
within unused sections of  media.

Note: For cutters that are connected via a serial port connection, VisionPro is able to query 
the head position automatically. However, for parallel port connections, you must visually 
confirm the head position.

1.	 Choose Engrave menu >> Engraving Defaults.
2.	 From the Output dialog, tick the Jog checkbox.
3.	 At this point, either use the Shape Tools flyout to add registration marks, or add 

registration marks in Engrave Preview mode.
4.	 Choose Engrave menu >> Output.
5.	 At the far-right of  the Cut Toolbox, click the Engrave button.
6.	 The Jog dialog will open, and the tool can be positioned for each registration mark.
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Tile Settings
If  the design exceeds the limits of  either the machine or material, then the job must be 
divided into tiles that can be output as separate jobs. If  tiles can be repositioned to all fit 
within the available material, then they can be as a single job.

When creating a design, the dimensions of  the loaded material should be considered, and 
one should be mindful of  the maximum physical limits of  the machine. For example, 
consider a roll of  tractor-fed media. Not only is the width of  the media a constraint, but the 
teeth of  the tractor-feed also restricts the width. As a general rule, consult the Operator’s 
Manual to confirm the physical limits of  the machine.

Creating tiles in Engrave Preview mode
1.	 Choose Engrave menu >> Output.
2.	 In the Cut Toolbox, click the Tile button.
3.	 A dashed rectangular bounds will appear around the design.
4.	 Move the cursor over an edge of  the bounds, such that the cursor becomes a 

bidirectional arrow.
5.	 Click-and-drag to create a tile line. Both vertical and horizontal tile lines can be created 

in this fashion.
6.	 After the tile lines have been created, it is possible to select only some of  the tiles for 

printing.
7.	 For example, tiles can be clicked, such that only tiles with an ‘X’ will be cut.
8.	 However, if  none of  the tiles have an ‘X’, then ALL of  the tiles will be cut.
9.	 Click Apply to finish editing the tiles.
10.	 Drag the tiles to reposition them upon the material.

Filter By Color
The Filter By Color option is used to send only one color layer as output to the machine. 
This feature is typically used when cutting shapes from different colors of  vinyl, or where 
tool operations have been assigned colors according to the tool type. If  thick line styles are 
in the design, then the line colors will also be filtered.

Filter By Color can be enabled in the following ways:

A.	 Choose Engrave menu >> Engraving Defaults, and then tick the Engrave by 
Color checkbox. This will cause the Filter by Color dialog to automatically open 
in the Engrave Preview state.

B.	 Choose Engrave menu >> Engraving Defaults, and then in the Cut Toolbox 
click the Filter by Color. The Filter by Color dialog will open.
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Filter by Color Dialog
Use the Filter by Color dialog (Fig. 38) to choose the color layer that will be output. Once 
the design elements belonging to that color have been output, the dialog will re-open, where 
either the same or another color layer can then be chosen.

Output Tool Usage

Engrave menu >> Output Tool Usage

Output Tool Usage is an estimation tool that collects statistical information about the 
performance of  the tools being used in cutting or plotting. A variety of  data is gathered 
about each tool, such as the overall distance traveled, the number of  jobs completed, and 
the date of  the last tool change. Using this data, comparisons between successive tools may 
be used to make an informed decision about when tools are likely to decline significantly 
in performance. Tools may then be replaced in advance of  this decline, thereby preventing 
materials from being wasted by an old tool.

Estimate Time for Current Job
When using this option, be prepared to record the approximate time that is needed to 
complete the next cutting job. After the job is completed, you will be asked to enter the time 
that was expended in completing the job.

Note: From the Help menu, the TimeSign feature can be used to record the 
expended time.

Once the expended time has been set, use Engrave menu >> Show Traveled Distance to 
estimate how much time will be required to cut other jobs. By using this estimate, you can 
better manage your own time, since you will be able to work on other tasks and return when 
the current job is complete.

Fig. 38 - Use the Filter Layer to choose the color that will be 
output, and then click the Select button.

If the Filter Registration Marks option is enabled, then registration 
marks will be cut with all layers.
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Weed and Power Weed
Weeding is used with cut vinyl applications, where the cut shape must be peeled away from 
its backing. When peeling a vinyl shape, the risk is that it doesn’t pull easily from the backing, 
which can result in unexpected stretching of  the vinyl. This is particularly problematic with 
small text shapes. 

To avoid stretched vinyl, a weed border may be created, which is essentially an extra 
rectangular cut around the shape. Once cutting is done, the rectangular cut can be peeled 
away, followed by the inner shape.

Weed borders can be created in the following ways:

□□ Choose Shape Tools flyout >> Weed Border. This will create a rectangular weed line 
at the indicated offset around the design.

□□ Choose Shape Tools flyout >> Power Weed. Power Weed is like the Weed Border 
tool, except that additional weed lines can be dragged from the edges of  the border. 
Such additional weed lines are typically used to bisect text shapes.

□□ In Engrave Preview mode, left-click the Weed button to create a weed border. The 
offset amount can be set by right-clicking the Weed button.

Note: Weed lines will not cut into a given shape.
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Chapter 7

Laser Engraving

In This Section…
□□ Configuring the workspace for laser engraving designs
□□ Preparing line art and images for laser engraving
□□ Enhancing the quality of  engraved images
□□ Setting preferences within the laser engrave driver

This chapter describes how to configure and output different types of  laser engraving 
output. For line art shapes (i.e., vector shapes), the contour of  such shapes can be output 
as cut lines, and the fill color as a raster fill. In addition, the Photo Laser tool can be used to 
prepare an image for laser engraving.

Installing the Printer Driver
Like a desktop printer, a laser engraver uses the File menu >> Print command to send 
output. As such, the printer driver that was included with the laser engraver should be 
installed. Typically, the printer driver is on a CD that was shipped with the laser engraver, 
otherwise the manufacturer web site should be checked for the latest driver.

Preparing a Laser Engraving Job
Whereas cutting to a rotary engraver uses the Engrave menu >> Output command for 
sending a job, laser engravers use the File menu >> Print command because the printer 
driver is used to interpret the image data for laser engraving. In this manner, laser engravers 
can interpret object fills and strokes as cut data.

1.	 Begin by creating a new workspace. The Plate Size dialog will query for the size of  
your engraving bed.

2.	 Typically, the Width and Height should be set according to the cutting area of  your 
machine.
These settings can be modified later using Layout menu >> Plate Size.
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Set a Default Color Palette
1.	 From the Options menu, choose Palette >> Load >> Set Default.
	 This command is also available through the Shop Palette context menu.

2.	 The Default Palette browse dialog will open.
3.	 From the VisionPro install directory, browse to the Palettes >> Engrave directory.
4.	 In the Engrave directory are an assortment of  color palettes per different manufacture 

of  laser engraver. Each palette contains colors used by the given manufacturer to 
indicate speed and power.

5.	 Choose the color palette that corresponds to your laser engraver, and then click the 
Save button.

6.	 From the File menu, start a new workspace by choosing New.
7.	 Along the bottom of  the workspace, note that the Shop Palette has loaded the 

manufacturer palette that you had previously set as the default.

Setting Fill and Stroke Colors
With laser engravers, object fill colors produce an engrave fill, and hairline colors produce a 
cutting line.

1.	 Under the View menu, confirm that there is a checkmark beside the Show Fill option.
2.	 Under the View menu, confirm that there is a checkmark beside the Show Tool Paths 

option.

3.	 Create a circle shape and assign a black fill.
	 (i.e., select the circle and left-click black in the Shop Palette)

4.	 Draw a square around the circle and assign an Invisible fill (Fig. 39).
	 (i.e., select the square and left-click Invisible in the Shop Palette)

5.	 Select the square shape.
6.	 From the Stroke and Fill Tools flyout, choose Tool Diameter.
7.	 In the SmartBar, choose a Hairline style, and set a red stroke color (Fig. 40).
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Fig. 39 - Assign an invisible fill to the square.

Fig. 40 - Within the laser engraver’s printer driver, the red color represents a specific 
power and speed setting.
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Printing to the Laser Engraver
As mentioned previously, laser engraving output is driven through a printer driver, so output 
from VisionPro is done using the File menu >> Print command.

1.	 Choose File menu >> Print to open the Print dialog (Fig. 41).
2.	 On the Printer tab, select your laser engraver.

Note: If  your laser engraver is not listed, then refer to the installation instructions provided 
with your laser engraver.

3.	 Tick the Preview checkbox.

4.	 Click the Preferences tab (Fig. 42).
5.	 Tick the Print As Shown On Screen checkbox.
6.	 Click the Plate Area option.
7.	 If  required, tick the Print by Colors option, which is used to maintain a particular 

sequence in which the objects are cut.
8.	 On the Printer tab, click the Setup button.
9.	 The Properties dialog for your laser engraver will open.

Fig. 41 - The driver for the laser engraver will appear in 
the Print dialog like that of a printer driver.
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10.	 The controls on the Properties dialog will vary according to your model of  laser 
engraver (Fig. 43). For specific instructions concerning these controls, please refer to 
the documentation provided with your laser engraver.

11.	 The following aspects of  the Properties dialog should be checked:
□□ For the colors defined within the driver, adjust the power and speed settings as 

required.
□□ For each color, set the pen mode to output both raster and vector data.
□□ Confirm that the engraving area is correct.
□□ Set the cutting mode to Black and White.

Fig. 42 - The Photo Laser dialog provides specialized 
filters that are used to prepare an image for optimal laser 
engraving output.
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12.	 Click OK to accept the Print dialog settings and enter the Print Preview page.

Sending the Laser Engraving Job
1.	 The file is ready to be output.
2.	 Confirm that the machine is online and loaded with the appropriate material.
3.	 In Print Preview, click Print to begin engraving.

Fig. 43 - The Properties dialog controls will vary according to the 
model of laser engraver.
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Preparing an Image for Laser Engraving
The Photo Laser tool is used to prepare an image for output through a laser engraver. Various 
image filters are available for improving the quality of  the image, and you can choose from 
preset settings that have been configured for different types of  material. Since a laser engraver 
is essentially a monochrome device (laser on, or laser off), any color information retained in the 
image is not useful, so the resulting photo laser image will be in monochrome format.

1.	 Import an image onto the workspace.
2.	 From the Transform menu, choose Photo Laser >> Interactive.

3.	 The Photo Laser dialog (Fig. 44) will preview the effect of  applying the various filters.
4.	 In the Filter list, right-click will toggle a filter between ON/OFF.

Suggestions for adjusting filters from scratch

Note: In the lower-left corner of  the Photo Laser dialog, click the Load Presets button 
to choose from an assortment of  parameter files that have been configured for various 
materials.

If  you wish to adjust the Photo Laser settings without using preset values, then it is recommended 
that you start with only one filter, and then incrementally increase the number of  filters until you 
achieve the desired results. For example:

□□ Right-click to turn OFF all the filters, except for the Histogram filter.
□□ Adjust the Histogram filter to trim excess shadow (Black) and excess highlight (White).
□□ If  necessary, adjust the midtone (Gamma) to obtain more balance in the resulting shades.

Fig. 44 - The Photo Laser dialog provides specialized filters that are 
used to prepare an image for optimal laser engraving output.
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□□ At this point, the image can be further refined by incrementally turning on more filters, one 
by one, and making adjustments as appropriate.

□□ For example, turn ON an Edge filter, set it to Unsharp Mask, and then adjust the 
Amount, Radius and Threshold to find values that produce good results.

□□ Then turn ON the Threshold filter and adjust the Threshold slider to help sharpen the 
image.
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Chapter 8

Drafts and proofs

In This Section…
□□ Printing to a Windows printer
□□ Adding rough notes to your VisionPro design
□□ Collecting notes about the customer and design
□□ Creating a layout template for your customer proofs
□□ Sending previews to customer via e-mail

Windows Printer Driver
The File >> Print command is used to print to a desktop printer. For a printer to be available, its 
printer driver (provided by the manufacturer) must be installed in the Windows Control Panel.

Using the Print dialog relies upon Microsoft’s color management and the printer driver 
to control the print layout, quality, and color integrity of  the printed image. Though this 
method is common to all Windows applications, it is not recommended for printing large 
signage.

Preferences when Printing a Draft
Choose File menu >> Print to open the Print dialog. The Print dialog settings are used to 
preview the draft and choose draft options.

□□ On the Printer tab, enable the Preview option. When the OK button is clicked, the 
print job will be previewed, which will allow you to position and scale the draft.

□□ On the Preferences tab, tick the Dimensions and Notes option. This will allow any 
dimensions or notes to be printed.

□□ If  it is helpful, then enable the Guidelines or Grid Lines options.
□□ To avoid printing weed borders in the draft, enable the Do Not Print Weed Border 

option.
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Dimensions and Notes
On the VisionPro workspace, dimensions and notes are created from the Measure Tools 
flyout. When dimensions are scaled, the measurement will be updated automatically. 
Similarly, if  dimensions are grouped with shapes, then scaling the group will update the 
measurement automatically.

□□ Dimension – Measure the distance between two points.
□□ Object Dimension – Measure the height or width of  the selected object.
□□ Arrow Draw – Annotate the workspace. For each arrow drawn, a note may be created. 

Double-click the arrow to edit its thickness.
□□ Notes – Add descriptive notes to the workspace.

Job/Cost Notes
The Job/Cost Notes are used to include additional information about the customer, and 
construction details for the design. When a draft is printed, the Job/Cost Notes should be 
printed as well to serve as a reference.

For future jobs, customer contact information can be reused. In the Job Notes Summary 
dialog, the company name can be selected from the drop-list.

Creating a Draft Template
When a VisionPro workspace is saved, its file type is a CADlink Drawing File (CDL). A 
“template file” is like a regular CDL file, except that it also includes variable fields. When the 
template file is opened, the variable fields are either completed automatically (such as date 
fields), or VisionPro will prompt you for the text (such as customer name).
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Tools when working with template files:
□□ File >> Open – Load a template file. Variable fields like Time and Date will be 

automatically updated. For other fields like File and Text, you will be prompted to 
complete the field.

□□ File >> Edit Template… – Load a template file without completing the text fields.
□□ Layout >> Templates >> Set Template – Use the Text Compose tool to create a 

text shape. The text can then be selected and converted into a variable field of  type: 
File, Date, Time, or Text.

□□ File >> Save – Save the template file with variable fields.
□□ File >> Save as… – After loading a template file and completing the variable fields, 

save the file under a new name.

After using File >> Open to load a template file, make sure that the file is saved under a new 
name. Otherwise, you will overwrite the original template file.

Example of creating variable text
1.	 Use the Text Compose tool to create a text shape “Customer Name”.
2.	 Select the text shape, and then choose Layout >> Templates >> Set Template >> 

Text.
3.	 Use File >> Save as… to save the template file.
4.	 Close the file and start a new VisionPro workspace.
5.	 Use File >> Open to open the template file.
6.	 Note that you are prompted to enter text for “Customer Name”.
7.	 After the template has been loaded, use File >> Save as… to save the file under a new 

name.

Load an example template file
1.	 Use the File >> Open command to load “portrait.cdl” from the CADlink \ VisionPro 

\ Template directory.
2.	 You will be prompted to enter text for: File Name, Designer, Contact, and Customer.
3.	 You will then be prompted to import a previously saved image file.
4.	 Press [F8] to see the complete design, which can be used as a proof  for sending to 

customers.
5.	 Note that the date has been updated automatically.
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Send Image by E-mail
Use the Send Image by E-mail command to send a preview of  the current VisionPro 
design via e-mail.

□□ Instead of  including the entire design, it is possible for only selected objects to be 
previewed.

□□ Your company logo can be included with the preview, and clicking the logo can help the 
customer to locate your web site.

□□ Optionally, job notes can be included with the preview (see File menu >> Job/Cost 
Notes).

□□ When the Send button is clicked, the preview will be opened in your default e-mail 
client.

Example - Sending a PDF Proof
Use the following steps when configuring the Send Image by E-mail command to send a 
PDF proof  to a customer:

1.	 Make note of  the customer e-mail address, so that it is handy later.
2.	 Go Web menu >> Send Image by E-Mail.
3.	 The E-mail Preview dialog will open.
4.	 Click Settings to open the E-mail Preview Settings dialog.
5.	 Click Advanced to open the Advanced E-mail Preview Settings dialog.
6.	 From the Image format drop-list, choose PDF.
7.	 Click OK, and then click OK again.
8.	 From the E-mail Preview dialog, click Send.
9.	 The PDF Settings dialog will open.
10.	 Set the Quality = Low.
	 Choosing medium or high quality can create a file size that is excessive for e-mail. 

Generally, seek a file size that does not exceed 5MB, though preferably less than 1MB.

11.	 Click OK to proceed.
12.	 Per your e-mail client, an e-mail editing window will be populated with the job details, 

and the PDF will be added as an attachment.
13.	 Enter the e-mail address of  the customer, and type a descriptive subject line.
14.	 The message is now ready for sending.

Note: In older versions of  Microsoft Outlook (2000 and 2003), there is a bug that can 
prevent the Send button from working. In such a case, use the [ALT + s] shortcut to send 
the message.
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Example - Sending a PNG or JPEG Proof
Use the following steps when configuring the Send Image by E-mail command to send a 
PNG or JPEG proof  to a customer:

1.	 Make note of  the customer e-mail address, so that it is handy later.
2.	 Go Web menu >> Send Image by E-Mail.
3.	 The E-mail Preview dialog will open.
4.	 Click Settings to open the E-mail Preview Settings dialog.
5.	 Set the Preview image size slider according to the approximate image size that the 

customer should be provided with.
	 Generally, a pixel width from 400 pixels to 800 pixels will provide enough detail without 

exceeding a convenient viewing area of  a computer monitor.

6.	 Click Advanced to open the Advanced E-mail Preview Settings dialog.
7.	 From the Image format drop-list, choose either PNG or JPG (i.e., JPEG).
8.	 Click OK, and then click OK again.
9.	 From the E-mail Preview dialog, click Send.
10.	 Per your e-mail client, an e-mail editing window will be populated with the job details, 

and the PNG or JPG file will be added as an attachment.
11.	 Enter the e-mail address of  the customer, and type a descriptive subject line.
12.	 The message is now ready for sending.

Note: In older versions of  Microsoft Outlook (2000 and 2003), there is a bug that can 
prevent the Send button from working. In such a case, use the [ALT + s] shortcut to send 
the message.
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Appendix A

Hot Keys and Shortcuts

In This Section…
□□ Keyboard menu shortcuts
□□ Function keys
□□ Hot keys for aligning shapes
□□ Using guidelines for layout
□□ Node palette and node editing hot keys
□□ The grid and align palette
□□ Color palette tips, and color substitutions
□□ Selecting and manipulating shapes

Keyboard Menu Shortcuts
Please note that the VisionPro menus have keyboard shortcuts (not listed here) that will 
reduce your editing time. These shortcuts are listed next to each menu item, and these 
shortcuts can be customized (added, changed, deleted) by choosing Customize Shortcuts 
under the Options menu.

Function Keys
The function keys in VisionPro operate as follows: 

[F1] Help
[F2] Disable all Shop Palette color layers 

except the current target layer
[F3] Select all objects
[F4] Refresh the workspace
[F5] Zoom marquee
[F6] Zoom out

[Shift+F6] Zoom in
[F7] Zoom to selected object
[F8] Zoom to Plate Size
[F9] Toggle between current and previous 

zoom levels
[F10] Select the menu bar
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Align Selected Shapes
To align selected shapes quickly, use the following hot keys:

[ALT + 1] Align shapes along left edge of  bounds
[ALT + 2] Center shapes vertically
[ALT + 3] Align shapes along right edge of  bounds
[ALT + 4] Align shapes along top edge of  bounds
[ALT + 5] Center shapes horizontally
[ALT + 6] Align shapes along bottom edge of  bounds
[ALT + 7] Center shapes both horizontally and vertically

Align Shapes to the Plate Size
To align shapes to the plate size, use the following hot keys. Most of  these correspond to Layout 
menu >> Arrange and Distribute >> Align to Plate.

[ALT + Delete] Left – Align with left edge of  plate
[ALT + Page Down] Right – Align with right edge of  plate

[ALT + Insert] Top – Align with top edge of  plate
[ALT + Page Up] Bottom – Align with bottom of  plate

<no default> Center – Align with center of  the plate.
[ALT + End] Center Horizontally – Center horizontally 

along height of  plate
[ALT + Home] Center Vertically – Center vertically along width 

of  plate
[Ctrl + Q] Equal Spacing – Space text objects equally over 

height and width of  plate.
<no default> Equal Vertical Spacing – Space text objects 

vertically across plate.
<no default> Equal Horizontal Spacing – Space text objects 

horizontally across plate.
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Align Shapes to Last Selected Object
When using [Shift] to select a collection of  objects, the following hot keys will align shapes to 
most recently selected object”

[L] Left – Align with the left edge of  the last object.

[R] Right – Align with the right edge of  the last object.

[T] Top – Align with the top edge of  the last object.

[B] Bottom – Align with the bottom edge of  the last object.

[E] Horizontally – Center horizontally along height of  last object.

[C] Vertically – Center vertically along width of  last object.

Guidelines
When dragging shapes, guidelines are used for precise alignment. A shape will “snap” to the 
location when it is dragged over a guideline.

□□ When there is no selection, right-clicking on the workspace will open the Edit Guides 
dialog.

□□ Under the Options menu, choosing Guides >> Edit Guides will open the Edit 
Guides dialog.

□□ Right-clicking a ruler will create a guide.
□□ For a selected shape, press [Shift] and right-click the shape nubs to create guides (not 

when editing a parametric shape).
□□ To add guides when node editing, press [Shift] and right-click the node.
□□ When dragging a guide, press [Shift] to constrain the guide to the nearest ruler 

increments.
□□ To lock guides in place, open the Edit Guide dialog and check the Lock Guides 

checkbox.
□□ To temporarily hide the guides, choose Options menu >> Guides >> Use Guides. 

The shortcut to toggle guides On/Off  is [ALT + W].
□□ To remove a guide, press [Shift] and right-click the guide (when there are no objects 

selected).
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Node Editing
When node editing a polygon or polyarc object, clicking the fill region of  another object will 
switch node editing to the other shape. When node editing an object that overlaps another 
object, hold the [ALT] key to prevent the accidental selection of  the underlying object.

The Node Palette
When editing a polygon or polyarc object, pressing the right-mouse button will access the 
Node Palette, which provides commonly used tools for changing node type, joining and 
breaking nodes, and setting the start point and direction for routers and engravers.

Please note that since polyarc objects are composed only of  curve nodes, the Node Palette 
will not allow you to change the node type for polyarcs (Fig. 45).

Fig. 45 - The Node Palette as it appears for polygon 
shapes (left), and polyarc shapes (right). Polygons 

can have Corner, Curve and Tangent nodes, whereas 
polyarcs use only Curve nodes
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The Align Palette
The Align Palette (Fig. 46) provides a quick means of  snapping a selected node to the 
nearest grid line or intersection. In addition:

□□ Set Origin will set the grid origin according to the selected node.
□□ Resize Grid will resize the grid increments based on the distance between the selected 

node and the origin.
□□ If  necessary, the origin can be reset via Options menu >> Reset Origin.
□□ The Grid Size can also be set from the General Preferences dialog.

Fig. 46 - Select a node, and then use [Ctrl + right-click] to access the Align Palette.
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Polygon Editing Hot Keys
In addition to the Node Palette, the following keyboard hot keys are available when editing 
polygon objects:

□□ (A) Add node – Create node at current cursor location.
□□ (C) Change node – Cycle type of  selected node. Type will cycle through Corner, 

Curve, and Tangent.
□□ (R) Remove – Delete the selected node.
□□ (L) Locate origin – Set grid origin to selected node.
□□ (G) Grid dimensions – Set the grid size as the distance between the selected node and 

the grid origin.
□□ (S) Snap to intersection – Move selected node to the nearest grid intersection.
□□ (H) Snap to horizontal grid line – Move node to the nearest horizontal grid line.
□□ (V) Snap to vertical grid line – Move node to the nearest vertical grid line.
□□ (J) Join – Join two nodes with a connecting line.
□□ (B) Break – Break contour at selected node.
□□ [F3] – Select all nodes.
□□ [ALT + F3] – Inverse selects all nodes.
□□ (U) Alternate Select – Select every other node of  currently selected nodes.
□□ (D) Deselect – Clear the current node selection.
□□ (O) Create perfect circle – Form nodes into a perfect circle.
□□ (T) Toggle start point – Set the start point for routing or engraving this object.
□□ (K) Click – Select the node under the mouse cursor.
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Polyarc Editing Hot Keys
In addition to the Node Palette, the following keyboard hot keys are available when editing 
polygon objects:

□□ (A) Add node – Create node at current cursor location.
□□ (R) Remove – Delete selected node.
□□ (L) Locate origin – Set grid origin to selected node.
□□ (G) Grid dimensions – Set the grid size as the distance between the selected node and 

the grid origin.
□□ (S) Snap to intersection – Move selected node to nearest grid intersection.
□□ (H) Snap to horizontal grid line – Move selected node to nearest horizontal grid line.
□□ (V) Snap to vertical grid line – Move selected node to nearest vertical grid line.
□□ (J) Join – Join two nodes with a connecting line.
□□ (B) Break – Break contour at selected node.
□□ [F3] – Select all nodes.
□□ [ALT + F3] – Inverse selects all nodes.
□□ (U) Alternate Select – Select every other node of  currently selected nodes.
□□ (T) Toggle start point – Set start point for routing or engraving this object.
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Color Palette Tips
When clicking a color in the Shop or Job Palettes, additional tools are activated by pressing 
the [Shift], [Control], or [ALT] keys. The following table summarizes these modifiers:

□□ Left-click – Set fill color of  current object
□□ Right-click – Set line style color of  current object
□□ [Shift] + Left-click – Select all objects of  that fill color
□□ [Control] + Left-click – Disable the color plate. All objects with that fill color will 

appear as dashed outlines.
□□ [ALT] + Left-click – Disable all color plates, except for the plate that was clicked

You can also use these modifiers with the Sheet Layer and Halftone Palettes.

Job Palette Substitutions
In addition to listing colors, the Job Palette can be used to perform global search-and-
replace of  colors, primers, halftones, etc.

Set all red shapes to a blue fill color
1.	 Suppose that you have several red shapes
2.	 In the Job Palette, click the ellipsis button and choose Color View from the context 

menu
3.	 Note that the red color appears in the Job Palette
4.	 From the Shop Palette, drag a blue color plate and drop it onto the red Job Palette color

Replace all shades of a spot color
1.	 Suppose that you have five shapes with different tints of  a gold spot color, say 100%, 

80%, 60%, 40%, and 20% tint
2.	 In the Job Palette, click the ellipsis button and choose Foil View from the context 

menu
3.	 Note that the Job Palette lists the different shades of  gold as a single color plate
4.	 From the Shop Palette, drag a green spot color and drop it onto the gold Job Palette 

color

Selecting and Manipulating Shapes
To select a shape, click within the fill area of  the shape. If  Show Fills is off  (under the View 
menu), then select the shape by clicking along its contour.

If  the [ALT] key is used as a modifier key, then the shape will only become selected by 
clicking along its contour. This is a useful means of  differentiating from between several 
clustered shapes.
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Sweep Selecting Objects
A sweep select is simply a quick means of  selecting several objects by surrounding the 
objects with a marquee. Modifier keys may also be used as follows:

Shift-sweep Select
□□ Add the objects to the current selection.

Control-sweep Select
□□ All objects that fall within bounds of  the marquee will become selected. The current 

editing operation (if  any) will be applied to the objects.

Alt-sweep Select
□□ For small objects that are within the area of  a larger object, use [ALT] + marquee to 

select the small objects without selecting the larger object.
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Appendix B

Feature Locator

In This Section…
□□ Workspace Settings and Customizations
□□ Line Art and Vector Shapes
□□ Text Editing
□□ Importing and Exporting File Types
□□ Color Palettes
□□ Image Creation and Editing
□□ Design Layout and Editing
□□ Printing
□□ Engraving

This appendix shows how to locate specific features in VisionPro. To use this list, locate 
the VisionPro feature name that you want (listed in alphabetical order), and then use the 
sequence that is given with that feature. For example, features for customizing the grid 
would be listed as follows:

Grid Lines (change between lines and dots)
Options menu  Grid  Show Grid as Lines

Grid Size
Options menu  VisionPro Setup  General Preferences  Grid Size
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Workspace Customizations

Keyboard shortcuts
Options  Customize Shortcuts

Warning dialog reset
Options  VisionPro Setup  General Preferences  Reset 

Multiple VisionPro Windows

Enable multiple windows
Options  Multiple Instance

Multiple windows – Close
File  Close

Multiple windows – Close All
File  Close All

Plate Size

Plate size
Layout  Plate Size

Plate Size outline On/Off
View  Show Plate

Snap to plate size
Options  Snap to Plate

Create plate shape
Layout  Plate Object



117Appendix B - Feature Locator

Line Art and Vector Shapes

Basic Shape Creation
Tools toolbar  Shape Tools 

Clip art shapes
Layout  Clip Art Viewer

Convert to polyarc / polygon
Arrange  Convert To  Polyarc / Polygon

Combine Shapes
Arrange  Make Path

Sketch Line Art
Tools toolbar  Graphics Edit Tools  Node / Free / Arc Edit

Stretch
Arrange  Stretch

Weed border object
Tools toolbar  Shape Tools  Weed border

Weld tools
Tools toolbar  Weld Tools

Shape Fills

Fill colors On/Off
View  Show Fill

Fill Color
[Left-click] a Shop Palette color

Gradient fill color
Tools toolbar  Stroke and Fill Tools  Gradient Fill

Blend colors between two shapes
Transform  Metamorphosis

Pattern fills using an existing bitmap pattern
Tools toolbar  Stroke and Fill Tools  Pattern Fills
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Stroke Width and Tool Diameter

Highlight selected objects
Options  VisionPro Setup  Selection Tool Settings  Highlight selected objects

Show tool paths
View  Show Tool Paths

Show width of tool paths
View  Show Tool Diameter

Hairline shown for line art
View  Show Fill

Add stroke
Tools toolbar  Stroke and Fill Tools  Tool Diameter

Stroke color
[Right- click] a Shop Palette color

Color Palettes

Shop Palette
View menu  Palettes  Show Shop Palette

Edit Color
<Double-click a Shop Palette color >

Create Custom Color
Shop Palette context menu  Custom Color Creator

Manufacturer Palette
Shop Palette context menu  Open Manufacturer Palette
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Text Editing

Install Font
File  Install  Fonts

Create text
Tools Toolbar  Text Tools  Text Compose

Text To Graphics
Arrange  Text To Graphics

Fit Text To Arc
Transform  Fit Text To Arc

Kern a selected text shape
Tools Toolbar  Text Tools  Text On-Screen Kerning

Meld script letters into single shape
Tools toolbar  Weld Tools  Basic Weld

Remove slanted text
Edit Text  [Left-click] Font Slant Degree button

Spell Check

Spell check all text shapes
Tools Toolbar  Text Tools  Spell Check

Spell check current text shape
Edit Text  Spell Check
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Images and Bitmaps

Convert line art to bitmap
Transform  Render To Bitmap

Change Bitmap Color Mode
Image  Mode

Clip Bitmap to Line Art
Position shape over bitmap  Select both objects  Arrange menu  Clipping

Crop Background of Bitmap
Image  Fluid Mask (if Fluid Mask has been purchased)

Color Adjustments
Image  Color Adjustments (e.g., Levels, Brightness, etc.)

Image editing
Tools toolbar  Scan Tools  AccuScan 

Image menu filters
Image  Filters (e.g., Blur, Sharpen, Noise, Stylize)

Image Size and Resolution
Image  Image Size

Posterize image
Tools toolbar  Scan Tools  AccuScan  Posterize Region

Trace image into line art
Tools toolbar  Scan Tools  AccuScan  Trace

Plug-Ins

Plug-in activation
Image menu  Options  Plugin Paths
<Plug-ins appear under Image menu after their install location has been specified.>

Plug-in foreground and background color (used by select plug-ins)
Image  Options  Set Foreground Color

Plug-in install locations
Image  Options  Plugin Paths
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Clipping Paths

Clipping path
Arrange  Clipping  Clipping

Clipping path clear
Arrange  Clipping Clear

Importing, Exporting, Link to File

Export Images
File  Export (e.g., AI, EPS, etc.)

Export Line Art and/or Images
File  Export Image (e.g., BMP, JPEG, TIFF, etc.)

Export to PDF
File  Publish to PDF

Import a CDL file into current workspace
File  Import

Linked Images - Save all linked images within CDL file
File  Save Embedded File

Desktop Scanners

Scan an image
File  Acquire Image  Acquire

Scan an image as line art
File  Acquire Image  Acquire Vector

Scanner – Choose scanner
File  Acquire Image  Select Source
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Layout

Alignment
Layout  Arrange and Distribute  Alignment

Badges
Layout  Badges

Group
Layout  Group

Group Viewer
[Double-click] a group of objects

InstantReplay
Options  Use InstantReplay

Move shape above all other shapes
Arrange  Order  [To Front, To Back, Forward, Backward]

Move shapes above/below each other

Layout  Sequence  Sequence By List 

Nesting
Arrange  Block Nesting

Template file editing
File  Edit Template

Template text fields
Layout  Templates

Grid Settings

Grid – Objects snap to grid On/Off
Options  Grid  Snap to Grid

Grid origin position
Layout  Plate Size  Origin Selection

Grid origin reset
Options  Reset Grid
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Grid visible On/Off
View  Show Grid

Grid width and height
Options  VisionPro Setup  General Preferences  Grid Size

Snap to grid
Options  Grid  Snap to Grid

Guidelines

Guides creation 1
[Right-click] a ruler

Guides creation 2
[Shift] + [Right-click] an object handle

Guides deletion – all guides
Options  Guides  Remove All Guides

Guides deletion – one guide
[Shift] + [Right-click] an existing guide (no objects selected)

Guides editing 1
Options  Guides  Edit Guides

Guides editing 2
[Right-click] an existing guide (no objects selected)

Guides locking
Options  Guides  Edit Guides  Lock Guides

Guides visible On/Off
Options  Guides  Use Guides

Snap to guides
<Automatic for visible guides>
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Rotary Engraving

Contour cut objects
Engrave  Contour Cut

Add tool paths
Engrave  Create Tool Path

Tools toolbar  Tool Path Tools

Engrave preview mode
Engrave  Output

Output a rotary engraving job
Engrave  Output  Cut Toolbox toolbar  Engrave

Rotary Machine Configuration
Engrave  Engraving Defaults

Machine limits
Engrave  Engraving Defaults  Setup  Engraver tab  Machine Limits

Machine origin
Engrave  Engraving Defaults  Setup  Engraver tab  Options

Feeds and speeds
Engrave  Tool Options

Origin Jog
Engrave  Engraving Defaults  Origin Jog

Port setting for machine
Engrave  Engraving Defaults  Setup  Port tab

Laser Engraving

Laser Engraver Configuration
File  Print  Setup

Output a laser engraving job
File  Print

Prepare image for laser engraving
Transform  Photo Laser
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Symbols

3D Chisel Tool Path  85

A

AccuScan  74
AccuScan and Image menu filters  74
Acquire  55
Acquire Image  55
Acquire Vector  56
Alien Skin Plug-ins  73
Alignment  46
Alignment Hot Keys  44
Align Palette  44, 109
Align To Baseline  56
Array  47
Arrow Draw  100

B

Badges  50
Badge Text Substitution  51
Balance Colors…  66
Baseline alignment  56
Basic Weld  31
Bevel Bitmap Effects  60
Bitmap Creation  60
Bitmap Editing (AccuScan)  74
Bitmap Palette Colors  75
Bitmap Transformations  39
Blends using Metamorphosis  35
Block Shadow  40
Blur Filters  66

Noisy Blur  72

C

CADlink Plug-ins  73
Cast Shadow  40
Chisel Bitmap Effects  60

Clear Color  34
Clearing an Image Background  62
Clear Size/Move  33
Clip-Art  55
ClipArt

Decorative Borders  41
Clipping and Clipping Clear  38
Clipping an Image Background  62
CMYK  34
Color Adjustments  65
Color Blends  34
Color Palettes  28
Color Palette Tips  28, 112
Color Types  34
Compress Equally Over Copies  50
Contrast/Brightness…  65
Converting bitmaps into line art  76
Convert to Curves  56
Copyright Notice  9
Curves Dialog  65
Customizing Keyboard Shortcuts  105

D

Decorative Border  41
Decorative Border Clip-Art  41
Digitizing Tablets  57
Dimensions  100
Draft CDL Templates  100
Drafts and Proofs  99
Drill Center  86
Drill Contour  85
Drill Point  85
Drop Shadow  40

E

Easy Color Adjustments  65
Engrave Preview  86
Exporting Files  54

Index
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F

Feeds and Speeds  82
Female Tool Path  84
Fill Colors  33
Fill Tool Path  85
Filter By Color  88
Filters  66
Fit Text to Arc  31
Fit Text to Path  31
Flip  33
Fluid Mask  62
Foil Colors  34
Function Keys  105

G

Ginsu Knife  30, 38
Gradient Fill  34
Graphic Edit Tools  29
Grid lines  44
Groups of  shapes  37
Group Viewer  37
Guidelines  43, 107

H

Halftone Filter  67
Harry’s Filters (Plug-ins)  70
Histo Contrast…  65
Histo Equalize  66
Hue/Saturation…  65

I

Image Background (Deleting)  62
Image Cut  79
Image Editing (AccuScan)  74
Image Menu

Color Adjustments  65
Filters  66
Plug-In Filters  68

Image Size  61
Image Transformations  39

Image Type (Mode)  60
Importing Files  53
Inline  38
InstantReplay  32
Invert  65
Invisible Color  34
Invisible Color Blend  35
Iron filings  79

J

Job/Cost Notes  100
Job Palette  28
Job Palette Substitutions  112

K

Keyboard Shortcuts  105

L

LAB  34
Laser Engraving  91
Levels Tool  65
Line/Fill Button  33
Line Style  33

Show Tool Diameter  27

M

Male Tool Path  84
Merge Colors  75
Metamorphosis  35, 39
Mirror  33
Miter Limit  38
Move  33

N

Nesting  48
Node Editing  108
Node Edit Tools  29
Node Palette  108
Noise Filters  67, 72
Notes  100
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Nubs  32
Nudge  33

O

Object Dimensions  100
Online Tool Path  83
Order To Front  37
Outline  38
Output Tool Paths  79
Output Tool Usage  89

P

Pattern Fill  34
Perspective Shadow  40
Photo Laser  97
PhotoMachine  79
Plate Size  27
Plotter Jog  87
Plug-In Filters  68

Alien Skin Sampler  73
CADlink Collection  73
Harry’s Filter Collection  70
Redfield Collection  69
Richard Rosenman Collection  69

Posterize
Color Adjustments  65
Posterize Filter  73
Posterize Region (AccuScan)  75

Power Weed  90
Prepare to Vectorize Wizard  77
Previewing a Cut-Only Job  86
Process Color  34

R

Rain  79
Redfield Plug-ins  69
Registration Marks  87
Relief  Shadow  40
Remove Red Eye  67
Render Contour Bitmap  60
Rendering Bitmaps  60

Replacement Data File  51
Reset Origin  44
Resizing Images  61
Richard Rosenman Plug-ins  69
Rotary Engraving  81
Rotate  33
Round Corners  41

S

Scan and Trace Wizard  56
Scanning Artwork  55
Scratch Disk  59
Selecting and Manipulating Shapes  112
Selecting Shapes  32
Select Source  55
Send Image by E-mail  102
Sequence  47
Serializing Badge Data  51
Shadow  40
Shape Creation  29
Sharpen Filters  66
Sheet Layer Palette  28
Shop Palette  28
Show Traveled Distance  89
Size  33
Slant  33
SmartBar  28
Snap Angle  32
Spell Check  31
Spot Color  34
Spot Foil  34
Squares  79
Stars  79
Start Sequence  47
Stencils  42
Stretch Intensity  65
Stroke Color  33
Strokes  33

Show Line Style  27
Stylize / Artistic filters  67
Super Size Image  61
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Swap Colors…  66
Sweep Selecting Objects  113

T

Template CDL Files  100
Text Creation  30
Text to Graphics  38
Text Underline  31
Tile Settings (Cut-Only)  88
Tool Options  82
Tool Paths  83
Tools Toolbar  28
Tool Tracking  89
Tracing Images

Classic Vectorization Method  76
Prepare to Vectorize Wizard  77

Transformation  39
Transparent Bitmap Color  60, 75

U

Undo Setup  59
Ungroup  37
Unsharp Mask  66

V

Vectorization of  Images
Classic Vectorization Method  76
Prepare to Vectorize Wizard  77

W

Weed Borders  90
Weld Tools  37
Wiggle  79
Windows Printer Driver  99
Workspace Settings  27


